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Preface

This installation guide explains how to install and use the Sun StorageTek RAID
Manager software. You can use this software to manage RAID host bus adapters
(HBAs), such as the Sun StorageTek SAS RAID HBAs.

Before You Read This Document

You must be familiar with computer hardware, data storage, RAID technology, and
the input/output (I/O) technology. Also, you must be familiar with Direct-Attached
Storage (DAS) or Network-Attached Storage (NAS)—whichever is appropriate for
your storage space—and Storage Area Network (SAN) concepts and technology.

This document is written for advanced computer users who want to create a storage
space for their data. Advanced knowledge of storage networks is not required, but
you must be familiar with computer hardware, data storage, and Redundant Array
of Independent Disks (RAID) technology.

If you are using the Sun StorageTek RAID Manager software as part of a complex
storage system, such as a SAN, you must be familiar with network administration
terminology and tasks, have knowledge of Local Area Network (LAN), Direct-
Attached Storage (DAS), and SAN technology, and be familiar with the input/output
(I/0O) technology—such as Fibre Channel (FC), iSCSI, or Serial Attached SCSI
(SAS)—that you are using on your network.
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Terminology Used in This Guide

Because this document provides information that can be used to manage multiple
RAID products in a variety of configurations from DAS to SAN, the generic term
“storage space” is used to refer to the HBA(s) and disk drives being managed with
the Sun StorageTek RAID Manager software.

For efficiency, the term “components” or “component” is used when referring
generically to the physical and virtual parts of your storage space, such as systems,
disk drives, HBAs, and logical drives.

Many of the terms and concepts referred to in this document are known to computer
users by multiple names. In this document, this terminology is used:

m HBA (also known as adapter, controller, board, or card)

m Disk drive (also known as hard disk, hard drive, or hard disk drive)

m Logical drive (also known as logical device)

m System (also known as a server, workstation, or computer)

m Enclosure (also known as a JBOD, storage enclosure, or disk enclosure)

m Internal RAID storage (also known as direct-attached storage or DAS)

How This Document Is Organized

Chapter 1 helps you get started. It describes the Sun StorageTek RAID Manager
software and the Sun StorageTek RAID Manager Agent, explains the concept of
storage space, and provides a checklist of getting-started tasks.

Chapter 2 walks you through installing and logging into the Sun StorageTek RAID
Manager software, explains how to use the software with a firewall, how to start the
Sun StorageTek RAID Manager Agent, and introduces the permission levels.

Chapter 3 provides information you will need to know before you build your storage
space. It describes how to navigate the Main software window, use the different
views, and see information about your disk drives.

Chapter 4 walks you through building your storage space by creating logical drives.
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Chapter 5 explains how to customize the Sun StorageTek RAID Manager software.
Tasks in this chapter are optional and include logging in to remote systems, creating
display groups, customizing the views and other preferences, and customizing the
Sun StorageTek RAID Manager Agent.

Chapter 6 works with logical drives and hot-spares. It tells you how logical drives
work, how to create, modify, and delete them, and how to work with a hot-spare.

Chapter 7 provides information and steps to monitor your storage space.
Chapter 8 helps you schedule, monitor, and manage maintenance tasks.
Chapter 9 describes how to work with and manage display groups.

Chapter 10 describes how to manage the HBAs, disk drives, and enclosures in your
storage space.

Chapter 11 describes how to configure SNMP support.

Chapter 12 is for troubleshooting. Use this chapter to help you identify and correct
problems.

Appendix A provides a comparison of the RAID levels that the Sun StorageTek RAID
Manager software supports. It provides an overview of each to help you select the
best level of protection for your storage system.

Appendix B provides quick answers to common questions.

Appendix C provides a reference to the icons and buttons in the Sun StorageTek
RAID Manager software.

Using UNIX Commands

This document might not contain information about basic UNIX® commands and
procedures such as shutting down the system, booting the system, and configuring
devices. Refer to the following for this information:

m Software documentation that you received with your system
m Solaris™ Operating System documentation, which is at:

http://docs.sun.com
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Shell Prompts

Shell

Prompt

C shell
C shell superuser
Bourne shell and Korn shell

Bourne shell and Korn shell superuser

machine-names
machine-name#
$
#

Typographic Conventions

Typeface Meaning

Examples

AaBbCcl123 The names of commands, files,
and directories; on-screen
computer output

AaBbCc123 What you type, when contrasted
with on-screen computer output

AaBbCc123 Book titles, new words or terms,
words to be emphasized.
Replace command-line variables
with real names or values.

Edit your. login file.
Use 1s -a to list all files.

% You have mail.

o
s Ssu

Password:

Read Chapter 6 in the User’s Guide.
These are called class options.

You must be superuser to do this.
To delete a file, type rm filename.

Note — Characters display differently depending on browser settings. If characters
do not display correctly, change the character encoding in your browser to Unicode

UTE-8.
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Related Documentation

The following table lists the documentation for this product. The online
documentation is available at:

http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic

Application Title Part Number Format Location
Hardware Sun StorageTek SAS RAID 820-1847-nn  PDF Documentation CD,
Installation HBA Installation Guide HTML Online
Eight-Port, Internal HBA
Sun StorageTek SAS RAID 820-1260-nn  PDF Documentation CD,
HBA Installation Guide HTML Online
Eight-Port, External HBA
RAID Uniform Command-Line 820-2145-nn  PDF Documentation CD,
Management Interface User’s Guide HTML Online
Sun StorageTek RAID 820-2755-nn  PDF Documentation CD,
Manager Software Release HTML Online

Notes

Documentation, Support, and Training

Sun Function

URL

Documentation
Support

Training

http://www.sun.com/documentation/

http://www.sun.com/support/

http://www.sun.com/training/
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http://www.sun.com/training/
http://www.sun.com/support/
http://www.sun.com/documentation/
http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic

Third-Party Web Sites

Sun is not responsible for the availability of third-party web sites mentioned in this
document. Sun does not endorse and is not responsible or liable for any content,
advertising, products, or other materials that are available on or through such sites or
resources. Sun will not be responsible or liable for any actual or alleged damage or
loss caused by or in connection with the use of or reliance on any such content,
goods, or services that are available on or through such sites or resources.

XXX

Sun Welcomes Your Comments

Sun is interested in improving its documentation and welcomes your comments and
suggestions. Submit comments about this document by clicking the Feedback[+] link
at http://docs.sun.com. Please include the title and part number of your
document with your feedback:

Sun StorageTek RAID Manager Software User’s Guide, part number 820-1177-13.
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CHAPTER 1

Introduction

This chapter describes the Sun StorageTek RAID Manager graphical user interface
(GUI) software and its agent, explains the concept of a storage space, and provides a
list of getting-started tasks. The chapter contains the following sections:

m “Getting Started Tasks” on page 1

m “About the GUI Versus the BIOS Utility” on page 2

m “About the Sun StorageTek RAID Manager GUI Software” on page 2
m “About the Agent” on page 3

m “Growing Your Storage Space With the Software” on page 4

m “System Requirements” on page 8

Getting Started Tasks

The following tasks will enable you to get started with the Sun StorageTek RAID
Manager software:

1. Familiarize yourself with the software and its agent.

For more information, see the remainder of this chapter.
2. Install the software on every system that will be part of your storage space.

3. Start the software, or the agent only, on those systems.

For more information, see “Installing the Software” on page 9.

4. Explore the features of the software.

For more information, see “Exploring the Software” on page 23.

5. Build your storage space.

For more information, see “Building a Storage Space” on page 35.



6. Optionally customize the software and the agent.

For more information, see “Customizing the Software” on page 53.

About the GUI Versus the BIOS Utility

You can use the Sun StorageTek RAID Manager graphical user interface (GUI) or the
BIOS Configuration Utility to build your storage space. The Sun StorageTek RAID
Manager GUI is a software application that enables you to create and manage your
storage space and then monitor the storage from a single location. The BIOS
Configuration Utility is a BIOS-based utility that enables you to create and manage
controllers, disk drives and other devices, and arrays.

If you use the BIOS Configuration Utility to create arrays, the Sun StorageTek RAID
Manager GUI detects those arrays and displays them as logical drives in the GUL
For more information about the BIOS utility, see the Sun StorageTek SAS RAID HBA
Installation Guide Eight-Port, Internal HBA or Sun StorageTek SAS RAID HBA
Installation Guide Eight-Port, External HBA.

Note — The Sun StorageTek RAID Manager graphical user interface (GUI) is not
supported with the VMware technology. To configure your storage space with the
VMware technology, use the command-line interface (CLI) and the BIOS
Configuration Utility. The CLI is installed as part of the Sun StorageTek RAID
Manager software installation. For more information about the CLI, see the Uniform
Command-Line Interface User’s Guide at:
http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic

About the Sun StorageTek RAID
Manager GUI Software

The Sun StorageTek RAID Manager software is a graphical user interface (GUI) that
helps you build a storage space for online data, using RAID HBAs, disk drives, and
enclosures. Your storage space can include direct-attached—or internal
RAID—storage.

With the Sun StorageTek RAID Manager software, you can group disk drives into
logical drives and build in redundancy to protect your data and improve system
performance. You can also use the software to monitor and manage all the HBAs,
enclosures, and disk drives in your storage space from a single location.
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About the Agent

You can use the Sun StorageTek RAID Manager software to manage both internal
and external RAID storage. This document describes how to install and use the Sun
StorageTek RAID Manager software to build and manage internal RAID storage - a
RAID HBA and disk drives which reside inside, or are directly attached to, the
computer accessing them, similar to the basic configurations shown in these figures:

FIGURE 1-1 RAID HBA Configuration

Server with RATD HBA System running
and disk drives Sun StorageTek BAID
Manager software

etwork (SAN)
Connection
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:_..--—-' \%‘_@3}3%}’ R E
Server with Swstem runming Server with Storage enclosures
EAID HEA and Sun StorageTek EAID BRAID HBA, with disk drives
dizsk dnives Meanager software rmnning Sun nstalled
StorageTek EAID
Manager

When the Sun StorageTek RAID Manager software is installed on a system, the Sun
StorageTek RAID Manager Agent is also installed automatically. The Agent is like a
service that keeps the storage space running. It’s designed to run in the background,
without user intervention, and its job is to monitor and manage system health, event
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notifications, tasks schedules, and other on-going processes on that system. It sends
notices when tasks are completed successfully, and sounds an alarm when errors or
failures occur on that system.

The Agent uses less memory than the full application. If your storage space includes
systems that won’t be connected to monitors (and therefore won’t require the user
interface described in this document), you can choose to run the Agent only on those
systems instead of the full application (see “About the Agent” on page 3). You may
want to do this if system resources are limited, or if you want more system resources
available for other tasks.

Note — Linux or UNIX users only—If your storage space includes systems without
X-Windows installed or running, you can run the Agent, even though you can’t run
the full Sun StorageTek RAID Manager software application.

You can manage and monitor systems running the Agent only by logging into them
as remote systems (see “Logging Into Remote Systems” on page 53).

You can also customize the Agent settings to suit your storage space requirements
(see “Customizing the Agent” on page 61).

Growing Your Storage Space With the
Software

As your requirements change, the Sun StorageTek RAID Manager software grows
with your storage space as you add more HBAs, more disk drives, more logical
drives, and more data protection.

A Simple Storage Space

This example shows a simple storage space that might be appropriate in a home
office or for a small business. This storage space includes one RAID HBA and three
disk drives installed in a server. For data protection, the disk drives have been used
to build a RAID 5 logical drive.
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FIGURE 1-2 Simple Storage Space Configuration

Internal Data and
Customer Data
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An Advanced Storage Space

This example shows how you can grow storage space to meet the expanding
requirements of your business. On the first server, segments of space from each disk
drive have been used to build two RAID 5 logical drives. A second server connected
to two 12-disk-drive enclosures has been added. The additional storage space has
been used to create two RAID 50 logical drives. The Administrator of this storage
space can create and modify logical drives and monitor both HBAs, disk drives, and
enclosures from a single system, called the local system (see “Logging Into Remote
Systems” on page 53).
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FIGURE 1-3 Advanced Storage Space Configuration
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Continuing to Grow Your Storage Space

As your needs change, the Sun StorageTek RAID Manager software will help you
grow storage space to include multiple HBAs, storage enclosures, and disk drives in
multiple locations.

In this example, multiple systems, servers, disk drives, and enclosures have been
added to the storage space. The Administrator can create and modify logical drives
and monitor all the HBAs, enclosures, and disk drives in the storage space from the
local system (see “Logging Into Remote Systems” on page 53).
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FIGURE 1-4 Multisystem Storage Space Configuration
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System Requirements

To install the Sun StorageTek RAID Manager software and create a RAID storage
space, each system in your storage space must meet these requirements:

m Computer with 1.2 GHz processor, or equivalent
m 1 GB of RAM, at minimum

m 100 MB of free disk drive space

m 256-color video mode

m One of these operating systems and technology with the minimum specified
versions:

» Microsoft Windows Server 2003, Standard Edition, 32-bit or 64-bit

= Microsoft Windows Server 2003, Enterprise Edition, 32-bit or 64-bit

» Red Hat Enterprise Linux (RHEL) 4 ES, 32-bit and 64-bit

= RHEL 4 AS Update 5, 32-bit and 64-bit

s RHEL 5 Server, 32-bit and 64-bit

s RHEL 5 Advanced Platform, 32-bit and 64-bit

» SUSE Linux Enterprise Server 9, SP4

m Solaris 10 8/07 (s10u4) OS for the x64 and x86 (32-bit and 64-bit) platforms
m Solaris 10 5/08 (s10u5) OS for the SPARC (64-bit) platform

s VMware ESX Server 3.0.2, Update 1

Note — The Sun StorageTek RAID Manager graphical user interface (GUI) is not
supported with the VMware technology. To configure your storage space with the
VMware technology, use the command-line interface (CLI) and the BIOS
Configuration Utility. The CLI is installed as part of the Sun StorageTek RAID
Manager software installation. For more information about the CLI, see the Uniform
Command-Line Interface User’s Guide at:
http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic

Note — For up-to-date operating system version support and drivers, visit
http://support.intel.com/support/go/sunraid.htm.
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CHAPTER 2

Installing and Starting the Software

The Sun StorageTek RAID Manager software must be installed on every system that
will be part of your storage space. This chapter describes how to install and start the
Sun StorageTek RAID Manager software. The chapter contains the following
sections:

m “Installing the Software” on page 9

m “Starting the Software” on page 16

m “Starting the Agent Only” on page 17

m “Using the Software With a Firewall” on page 19
m “Understanding Permission Levels” on page 20

m “Logging Out of and Into the Software” on page 21

Installing the Software

To install the software, obtain the Sun StorageTek RAID Manager CD from the HBA
ship kit and follow the installation instructions for your operating system:

m “Installing on the Windows OS” on page 10

m “Performing a Silent Windows Installation (Advanced)” on page 11
m “Installing on the Linux OS” on page 13

m “Installing on the Solaris OS” on page 14

Note — To obtain the latest version of the Sun StorageTek RAID Manager software,
go to http://support.intel.com/support/go/sunraid.htm.



http://support.intel.com/support/go/sunraid.htm

Note — Advanced users—To install the Sun StorageTek RAID Manager software
with the VMware technology, see “Installing On VMware Technology” on page 15.
Although the Sun StorageTek RAID Manger GUI is not supported, performing this
task will install the command-line interface (CLI), which allows RAID management.

Installing on the Windows OS

This section describes how to install the Sun StorageTek RAID Manager software on
systems running the Windows OS. See “System Requirements” on page 8 for a list of
the minimum supported operating systems.

Note — You need administrator or root privileges to install the Sun StorageTek RAID
Manager software. For details on verifying privileges, refer to your operating system
documentation.

If a previous version of the Sun StorageTek RAID Manager software is installed on
the system, you must remove it before beginning this installation. To uninstall the
Sun StorageTek RAID Manager software, use the Add/Remove Programs option in
the Windows Control Panel.

Note — Advanced users—To perform a silent installation, follow the instructions on
“Performing a Silent Windows Installation (Advanced)” on page 11.

V¥ To Install the Software on the Windows OS

1. Insert the Sun StorageTek RAID Manager Installation CD.

The Installation wizard opens automatically. (If it does not open, browse to the
CD in Windows Explorer, then click Autorun.)

2. Select Internal RAID Controller Setup or Custom Setup (advanced users only),
and click Next.

3. Click Next to begin the installation, click I accept..., then click Next.
4. Follow the on-screen instructions to complete the installation.

5. Repeat these Step 1 to Step 4 in order to install the Sun StorageTek RAID
Manager software on every Windows system that will be part of your storage
space.
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6. Continue with “To Start the Software on the Windows OS” on page 16.

Performing a Silent Windows Installation
(Advanced)

A silent installation uses command-line parameters to complete an installation
without messages or user interaction.

V¥ To Perform a Silent Windows Installation of the
Software

1. Insert the Sun StorageTek RAID Manager Installation CD.
2. Open a command prompt window and change to the CD directory.

3. Install the Sun StorageTek RAID Manager software by typing the following at
the command line:

setup.exe /s /v" /gn properties"

Where properties is one or more of the options listed in TABLE 2-1. Separate the
properties with spaces; separate feature names for the ADDLOCAL property with
commas (see examples on “Example Command-Line Installations” on page 13).
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TABLE 2-1  Sun StorageTek RAID Manager Property Options

Property Values

INSTALLDIR Specifies the installation path. If you are specifying the installation path, it
(Not required) ~must be set for a command-line install, and must be enclosed in escaped
quotation marks. For example:
INSTALLDIR=\"C:\Program Files\Sun\Sun StorageTek RAID
Manager\"
Note: If you do not explicitly set the installation path, the default path is
C:\Program Files\Sun\Sun StorageTek RAID Manager

ADDLOCAL Note: Use commas to separate multiple values.
(Required) ¢ ALL—Installs all of the following features. If you specify ALL, do not
also specify any of the following values.

* Manager—Installs the Sun StorageTek RAID Manager software. If this
feature is installed, your system will reboot if certain RAID cards that
use the filter driver are installed. If necessary, you can use the REBOOT
property to suppress this (see “REBOOT” on page 12).

¢ SNMPSupport—Installs SNMP support for the Sun StorageTek RAID
Manager software. If you specify the SNMPSupport value, the Manager
value is also specified automatically. (See “Configuring SNMP Support”
on page 155 for more information about SNMP support.)

* AsMReadme—Installs the Readme file and its Start menu shortcut.

* CLITools—Installs Command Line Interface tools.

REBOOT ¢ Force—Forces a reboot at the end of the installation.
(Not * Suppress—Suppresses a reboot unless files were in use and could not
Required) be overwritten during installation.

* ReallySuppress—Suppresses all reboots at the end of the installation.

Note: A reboot is only forced by the Sun installer if you have installed
Manager or DSM, or if any files can’t be overwritten.

Note — Synchronous Installation—To install the Sun StorageTek RAID Manager
software so that the setup . exe file does not close until the installation is complete,
add the /w parameter to setup.exe and run the application with the start
/WAIT command as shown in this example:

start /WAIT setup.exe /w /s /v" /gn OPTIONS"

You might want to do this for a batch file installation so that the setup will not
return until the installation is finished.

4. After a minute or two, the silent installation will complete and the Sun
StorageTek RAID Manager software icon will be accessible.
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Example Command-Line Installations

m To install the basic options, which include the Manager, Readme, and SNMP
support:

setup.exe /s /v" /gn ADDLOCAL=Manager,ASMReadme, SNMPSupport"
m To install just the Manager and suppress a reboot at the end of installation:
setup.exe /s /v" /gqn ADDLOCAL=Manager REBOOT=ReallySupress"
m To install all features silently, on a machine named COMP1234, and force a reboot:

setup.exe /s /v" /qn ADDLOCAL=Manager, ASMReadme,
SNMPSupport, CLITools REBOOT=Force"

m To install only the CLI Tools and suppress a reboot:
setup.exe /s /v" /gn ADDLOCAL=CLITools REBOOT=ReallySuppress"
m To install the Manager to a different installation path:

setup.exe /s /v" /gn ADDLOCAL=Manager INSTALLDIR=\"C:\Sun
StorageTek RAID Manager\""

m To install the Manager and have setup wait until the installation finishes before it
closes:

start /WAIT setup.exe /w /s /v" /gn ADDLOCAL=Manager REBOOT=
ReallySupress"

Installing on the Linux OS

This section describes how to install the Sun StorageTek RAID Manager software on
systems running the Linux OS. See “System Requirements” on page 8 for a list of the
minimum supported operating systems.

The Sun StorageTek RAID Manager software includes the Java Runtime
Environment (JRE).

Note — If a previous version of the Sun StorageTek RAID Manager software is
installed on your system, you must remove it before beginning this installation. Any
customization files you created with the previous version are saved and used in the
upgrade. To remove the Sun StorageTek RAID Manager software, type the rpm --
erase StorMan command.
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V¥ To Install the Software on the Linux OS

1. Insert the Sun StorageTek RAID Manager Installation CD.

2. Mount the Sun StorageTek RAID Manager Installation CD:
For Red Hat: mount /dev/cdrom /mnt/cdrom
For SUSE: mount /dev/cdrom /media/cdrom

3. Change to the cdrom directory:
For Red Hat: ed /mnt/cdrom/linux/manager

For SUSE: ed /media/cdrom/linux/manager

4. Extract the RPM package and install it:

rpm --install ./StorMan*.rpm

5. Unmount the Sun StorageTek RAID Manager Installation CD:
For Red Hat: umount /mnt/cdrom

For SUSE: umount /media/cdrom

6. Repeat Step 1 through Step 5 to install the Sun StorageTek RAID Manager
software on every Linux system that will be part of your storage space.

7. Continue with “To Start the Software on the Linux OS” on page 17.

Installing on the Solaris OS

Note — If a previous version of the Sun StorageTek RAID Manager software is
installed on your system, you must remove it before beginning this installation. Any
customization files you created with the previous version are saved and used in the
upgrade. To remove the Sun StorageTek RAID Manager software, type the pkgrm
RaidMan command.

V¥ To Install the Software on the Solaris OS

1. Insert the Sun StorageTek RAID Manager Installation CD.

The CD mounts automatically. (If it doesn’t, manually mount the CD using a
command similar to the one shown in this step. Refer to your operating system
documentation for detailed instructions.)

mount -F hsfs -o ro /dev/dsk/clt0d0s2 /mnt
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2. Install the Sun StorageTek RAID Manager software:
pkgadd —d/mount—point/solaris/manager/StorMan.pkg

3. Follow the on-screen instructions to complete the installation.

4. Eject or unmount the Sun StorageTek RAID Manager Installation CD.

Refer to your operating system documentation for detailed instructions.

Installing On VMware Technology

Note — The Sun StorageTek RAID Manager graphical user interface (GUI) is not
supported with the VMware technology. To configure your storage space with the
VMware technology, use the command-line interface (CLI) and the BIOS
Configuration Utility. The CLI is installed as part of the Sun StorageTek RAID
Manager software installation. For more information about the CLI, see the Uniform
Command-Line Interface User’s Guide at:
http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic

V¥ To Install On VMware Technology
1. Mount the Sun StorageTek RAID Manager Installation CD:
mount -r /dev/cdrom /mnt/cdrom

2. Change to the cdrom directory:

cd /mnt/cdrom/linux/manager

3. Extract the Linux Sun StorageTek RAID Manager RPM package and install it:

rpm --install ./StorMan*.rpm

Note — Ignore the note that says “Application can be started by typing
/usr/StorMan/StorMan.sh". The console has no graphical capability.

4. Use the command-line interface utility, arcconf, included with the Sun
StorageTek RAID Manager software to configure and manage disk drives.

For more information, see the Uniform Command-Line Interface User’s Guide
available at:
http://docs.sun.com/app/docs/prod/stortek.raid.hba#hic
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5. To use the Sun StorageTek RAID Manager software to connect remotely from
another system, open a range of ports in the built-in firewall by using this
command:

esxcfg-firewall -o 34571:34581,tcp,in,”StorMan”

For more information, see “Logging Into Remote Systems” on page 53.

Starting the Software

Note — You need root privileges to run the Sun StorageTek RAID Manager
software.

To start the Sun StorageTek RAID Manager software, follow the instructions for your
operating system. To start the Sun StorageTek RAID Manager Agent only, see
“Starting the Agent Only” on page 17. This section contains the following
subsections:

m “To Start the Software on the Windows OS” on page 16
m “To Start the Software on the Linux OS” on page 17
m “To Start the Software on the Solaris OS” on page 17

V¥ To Start the Software on the Windows OS

On systems running Windows, you can run the Sun StorageTek RAID Manager
software as a stand-alone application (like a regular software application), or in a
browser window (such as Microsoft Internet Explorer).

Note — Normally, you only need to run the Sun StorageTek RAID Manager software
in a browser window if you are working on a system that is not part of your storage
space (does not have an HBA installed). If the system you are working on is part of
your storage space, run the Sun StorageTek RAID Manager software as a standalone
application.

1. Choose Start > Programs > Sun StorageTek RAID Manager.
The Log In dialog box is displayed.

2. Enter the user name and password that you use to log on to the system, then
click Connect.
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Note — Each user name has a permission level associated with it. See
“Understanding Permission Levels” on page 20 for more information.

V¥ To Start the Software on the Linux OS

1. Type the following command to change to the Sun StorageTek RAID Manager
installation directory:

cd /usr/StorMan

2. Type the following command and press Enter:

sh StorMan.sh

3. When the Log In dialog box is displayed, enter the user name and password
that you use to log on to the system, and click Connect.

Note — Each user name has a permission level associated with it. See
“Understanding Permission Levels” on page 20 for more information.

V¥ To Start the Software on the Solaris OS

1. Change to the directory where the Sun StorageTek RAID Manager software is
installed:

cd /opt/StorMan

2. Launch the Sun StorageTek RAID Manager script:
sh StorMan.sh

Starting the Agent Only

Note — For more information, see “About the Agent” on page 3.

To start the Sun StorageTek RAID Manager Agent only, follow the instructions for
your operating system:

m “Starting the Agent on the Windows OS” on page 18
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m “Starting the Agent on the Linux OS” on page 18
m “Starting the Agent on the Solaris OS” on page 19

Starting the Agent on the Windows OS

On systems running Windows, the Sun StorageTek RAID Manager Agent starts
automatically when the system is powered on.

V¥V To Verify That the Agent is Running On the System

1. Open the Windows Control Panel.
2. Double-click Administrative Tools, then double-click Services.

3. In the list of services, check that the Sun StorageTek RAID Manager Agent is
installed and running.

If it is not, you can choose to restart it.

4. Manage and monitor the system by logging into it as a remote system (see
“Logging Into Remote Systems” on page 53).

The default settings for the Sun StorageTek RAID Manager Agent are suitable for
most storage spaces. To customize the settings for your specific requirements, see
“Customizing the Agent” on page 61.

Starting the Agent on the Linux OS

On systems running Linux, the Sun StorageTek RAID Manager Agent starts
automatically when the system is powered on.

V¥V To Verify That the Agent is Running On the System

1. Open a shell window.

2. Type this command:
ps -ef | grep StorAgnt.sh
If the Agent is running, it is listed as sh StorAgnt.sh.

3. Manage and monitor the system by logging into it as a remote system (see
“Logging Into Remote Systems” on page 53).
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The default settings for the Sun StorageTek RAID Manager Agent are suitable for
most storage spaces. To customize the settings for your specific requirements, see
s“Customizing the Agent” on page 61.

Starting the Agent on the Solaris OS

On systems running the Solaris OS, you must start the agent.

V¥ To Start the Agent On the System

1. Open a terminal window and type this command:
svcadm enable ADPTstor_agent

2. Manage and monitor the system by logging into it as a remote system (see
“Logging Into Remote Systems” on page 53).

The default settings for the Sun StorageTek RAID Manager Agent are suitable for
most storage spaces. To customize the settings for your specific requirements, see
“Customizing the Agent” on page 61.

Using the Software With a Firewall

If your network includes a firewall, you must unblock the ports listed in this section.
Unblock this port to ensure that the Sun StorageTek RAID Manager software
operates properly:

= 8003 (TCP)

Unblock these ports to allow the Sun StorageTek RAID Manager software remote
access to systems on your network:

m 34570 to 34580 (TCP)

= 34570 (UDP)

m 34577 to 34580 (UDP)
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Understanding Permission Levels

When you log into the Sun StorageTek RAID Manager software, your permission
level is identical to your operating system permission level. For example, if you have
Administrator permissions on your operating system, you also have Administrator
permissions in the Sun StorageTek RAID Manager software.

This section describes the three different permission levels.

About the Administrator Permission Level

Logging in as an Administrator allows you full access to manage and modify the
HBAs, disk drives, and logical drives that are part of your storage space.

V¥ To Log In as an Administrator

m Windows—Enter a valid user name and password for the Administrator or
Administrative User on the system. (The Administrative User is any member of
the local Administrators group, which can, in a Domain configuration, include
Domain Administrators.)

m Linux—Type root for the user name and enter the root password.

m Solaris—Type root for the user name and enter the root password.

About the User Permission Level

Logging in as a User partially restricts your access to the storage space, as described
in this table.

TABLE 2-2  User Restrictions

Tasks That Users Can Perform Tasks That Users Cannot Perform
Rescan HBAs Create logical drives

Save activity logs Modify logical drives

Verify disk drives (with and without fix) Delete logical drives

Verify logical drives (with and without fix) Delete hot-spares

Identify disk drives and enclosures Perform data migrations
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TABLE 2-2  User Restrictions

Tasks That Users Can Perform Tasks That Users Cannot Perform

Rebuild disk drives
Create hot-spares

Access the same information as Guests (see the
following section)

V¥ To Log In as a User

® Use your normal network user name and password at the Login window.

About the Guest Permission Level

Logging in as a Guest restricts your access to the storage space to view-only.

You can see all local and remote systems and view their properties windows, view

event logs, save configuration files and support archives, and browse the online

Help.

You cannot make any changes to the storage space.

V¥ To Log In as a Guest

® Click Cancel on the Login window.

Logging Out of and Into the Software

This section contains the following subsections:
m “To Log Out of the Software” on page 21
m “To Log Into the Software” on page 22

V¥ To Log Out of the Software

1. In the Enterprise View, click on the local system.

Chapter 2 Installing and Starting the Software
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2. In the menu bar, choose Actions, then click Log out.

You are logged out of the Sun StorageTek RAID Manager software.

V¥ To Log Into the Software

1. In the Enterprise View, click on the local system.
2. In the menu bar, select Actions, then click Log in.

3. Enter your user name and password, then click Connect.

See “Understanding Permission Levels” on page 20 for more information.
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CHAPTER 3

Exploring the Software

Before you build a storage space, read this chapter to familiarize yourself with the
main features of the Sun StorageTek RAID Manager software and learn to navigate
to the information you need.

This chapter contains the following sections:

“Navigating the Main Window” on page 23

“Using the Enterprise View” on page 24

“Using the Physical Devices View” on page 26
“Using the Logical Devices View” on page 27
“Revealing More Disk Drive Information” on page 29
“Checking System Status” on page 31

“Working in The Software” on page 33

“Getting Help” on page 33

Navigating the Main Window

The main window of the Sun StorageTek RAID Manager software has three main
panels, or views, in addition to the other features shown in this figure.

23



FIGURE 3-1 Sun StorageTek RAID Manager Main Window
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Resize the panels and scroll horizontally or vertically as required, to view more or
less information.

For more information about specific areas of the main window, see these sections:
m “Using the Enterprise View” on page 24.

m “Using the Physical Devices View” on page 26.

m “Using the Logical Devices View” on page 27.

Using the Enterprise View

The Enterprise View is an expandable tree with two main branches—the Internal
RAID branch, and the External RAID branch. The External RAID branch is not
covered in this document.

Under Internal RAID, the Enterprise View lists the local system (the system you are
working on) and any other systems that you are managing using the Sun StorageTek
RAID Manager software.
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Expand a system in the Enterprise View to the see its HBAs. (See “Logging Into
Remote Systems” on page 53 for more information about local and remote systems.)

Note — See “Creating Display Groups” on page 56 to learn how to group related
systems together in the Enterprise View.

When you select a component in the Enterprise View, the disk drives and logical
drives (“devices”) associated with it appear in the Physical and Logical Devices
Views, as shown in the following figure.

FIGURE 3-2 Enterprise View
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You can perform most tasks by selecting an HBA in the Enterprise View and
working with its associated devices in the Physical and Logical Devices Views.
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Using the Physical Devices View

When you select an HBA in the Enterprise View, information about the physical disk
drives and enclosures connected to that HBA are displayed in the Physical Devices

View.

FIGURE 3-3 Example of the Physical Devices View
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...2 enclosures (and 24 disk drives).
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TABLE 3-1

Physical Devices View Icons

Icon

Description

#

Disk drives designated as hot-spares have plus signs (+) beside them.

A blue plus sign means that the spare is protecting at least one logical
drive.

See “Working With Hot-Spares” on page 87 for more information.

A hot-spare with a yellow plus sign may not be large enough to protect
the logical drive it’s assigned to, or may not be assigned to a logical
drive.

See “Working With Hot-Spares” on page 87 for more information.

Hold your cursor over any disk drive to see its status,
port/connector/ID number, and maximum speed. You can also click the
arrow to see this same information for all the disk drives at the same
time. To reveal further information, use the View buttons to change how
the disk drives are displayed, as described in “Revealing More Disk
Drive Information” on page 29.

A disk drive shaded in light blue is not part of any logical drive. A disk
drive shaded half light/half dark blue has some space allocated to a
logical drive, and some space available.

To view the logical drives associated with a particular disk drive, see
“Using the Logical Devices View” on page 27.

If your storage space includes an enclosure, its enclosure management
device is represented by the following icon.

Using the Logical Devices View

When you select an HBA in the Enterprise View, information about the logical drives
and arrays associated with that HBA appear in the Logical Devices View. (A logical

drive is a group of physical disk drives that your operating system recognizes as a

single drive. For more information, see “Understanding Logical Drives” on page 67.)

Chapter 3 Exploring the Software
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FIGURE 3-4 Logical Devices View
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have been created.

TABLE3-2 Logical Devices View Icons

Icon Description

The RAID level of a logical drive is indicated by the number inside the
logical drive’s icon. For instance, the logical drive shown at right has
+® RAID 1. Logical drives protected by hot-spares have plus signs (+)
beside them.

Hold your cursor over any logical drive to see its name, status, and size.
You can also click the arrow to view this same information for all the
logical drives at once.

Click on a logical drive to highlight the disk drives that comprise it in the Physical
Devices View.In the following figure, six disk drives (plus one hot-spare) comprise
the selected RAID 5 logical drive.
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FIGURE 3-5 Relationship Between Physical and Logical Devices
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You can also click on any disk drive to see which (if any) logical drive it belongs to.
A disk drive shaded in light blue is not part of any logical drive.

Revealing More Disk Drive Information

You can reveal more information about disk drives by using the View buttons to
change how they are displayed.

By default, disk drives are displayed in the unexpanded Text Description View, as
shown in the following figure.

FIGURE 3-6 Unexpanded Text Description View

Physical devices | Logical devices

¥ Controller 2
Direct-attached devices Logical devices (2

Do o R

Or, if you are managing disk drives in an enclosure, the disk drives are displayed in
the Enclosure View.
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FIGURE 3-7 En
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Enclosure View button

Note — Not all enclosures are supported by the Sun StorageTek RAID Manager
software. Unsupported enclosures do not appear in Enclosure View.

Click the expand arrow to see basic disk drive information.

FIGURE 3-8 Text Description View
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Text Description View button

Click the Full Size Capacity View button to see the size capacities of the disk drives.
Disk drives or segments of disk drives that are included in logical drives are shaded

brown.
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FIGURE 3-9 Full Size Capacity View
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Click the Relative Size Capacity View button to see the size capacities of the disk
drives relative to each other. A full length bar is displayed for the largest disk drive.
Proportionally shorter bars are displayed for other disk drives.

FIGURE 3-10 Relative Size Capacity View
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Checking System Status

The Sun StorageTek RAID Manager software includes an Event Viewer for at-a-
glance system and event status information. The Event Viewer provides status
information and messages about activity (or events) occurring in your storage space.
Double-click any event to see more information in an easier-to-read format.
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FIGURE 3-11 Event Viewer Screen

Date
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hou228¥c Successfully applied the new configuration: controller 3.

Warning- and Error-level icons, shown in FIGURE 3-12, appear next to components

(such as systems and logical drives) affected by a failure or error, creating a trail, or
rapid fault isolation, that helps you identify the source of a problem when it occurs.
See “Identifying a Failed or Failing Component” on page 160 for more information.

FIGURE 3-12 Enclosure Warning and Disk Drive Error Icons

Enclosure
Warning 'ﬁ"_-.

Disk Drive
Ermror EI

If your storage space includes a HBA with a temperature sensor, or an enclosure
with an enclosure management device, such as a SCSI Accessed Fault-Tolerant
Enclosure (SAF-TE) processor, temperature, fan, and power module status is
displayed by status icons in the Physical Device view, as shown in the next figure.
These status icons change color to indicate status (see “Managing Enclosure Status”
on page 118).

FIGURE 3-13 Physical Devices View Icons
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For more information, see “Monitoring Storage Space” on page 95.

32 Sun StorageTek RAID Manager Software User's Guide ¢ May 2009



Note — By default, all Warning- and Error-level events activate an audible alarm. See
“Silencing and Testing the Audible Alarm” on page 120 for more information.

Working in The Software

The Sun StorageTek RAID Manager software provides multiple ways to work with
its menus and windows.

Most menu options are available by doing the following:

m Selecting items from the menu bar.

m Clicking buttons on the tool bar.

m Right-clicking on components in the main window. (Only tasks and windows

associated with a specific component are available on right-click menus.)

For simplicity, the tasks in this document are explained mainly using menu bar
options.

About the Actions Menu

Most of the main tasks in the Sun StorageTek RAID Manager software are part of the
Actions menu on the menu bar. Options on the Actions menu vary, depending on
which type of component is selected in the main window. For instance, managed
systems, disk drives, and hot-spares each have specialized Actions menus.

For an overview of all Actions menu options, see “About Viewing Actions Menu
Options” on page 194.

Getting Help

The Sun StorageTek RAID Manager software online Help includes conceptual
information, glossary definitions, and descriptions of on-screen menus and items, in
addition to step-by-step instructions for completing tasks.

To open the online Help, click the Help button. Alternatively, press the
F1 key, or in the menu bar select Help, then click Search or Contents. 42 Help |
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Press the Help button in a dialog box or wizard for help with that specific dialog
box, window, or procedure.

Additionally, you can find the most commonly asked-about information in
“Frequently Asked Questions” on page 189 of this document. For help identifying
features of the Sun StorageTek RAID Manager software, see “Buttons and Icons At-
a-Glance” on page 201.
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CHAPTER 4

Building a Storage Space

Once you have logged into the Sun StorageTek RAID Manager software, you can

begin to build storage space by creating logical drives. (For more information, see
“Understanding Logical Drives” on page 67.) This chapter describes how to start

building your storage space.

Note — You must be logged in as an Administrator to complete the tasks described
in this chapter.

The chapter contains the following sections:

m “Selecting a Configuration Method” on page 35

m “Express Configuration: Building the Easy Way” on page 36
m “Custom Configuration (Advanced)” on page 40

m “Building a RAID Volume” on page 47

m “Sun StorageTek SAS RAID HBA Support” on page 51

m “Managing Your Storage Space” on page 52

Selecting a Configuration Method

The Sun StorageTek RAID Manager software has a wizard to help you build (or
configure) logical drives, and offers two configuration methods to choose from,
depending on your needs:

m Express configuration (basic)—Automatically creates logical drives by grouping
together same-sized physical drives, and assigns RAID levels based on the
number of physical disk drives in the logical drive.
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Use the express method when you want to use all available disk drives in the
most efficient manner. For instructions, see “Express Configuration: Building the
Easy Way” on page 36.

m Custom configuration (advanced)—Helps you group disk drives, set RAID
levels, determine logical drive size, and configure advanced settings manually.

Use the custom method when you want to create specific logical drives with any
or all available disk drives. For instructions, see “Custom Configuration
(Advanced)” on page 40.

Note — Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.

Express Configuration: Building the
Easy Way

When you use express configuration, the Sun StorageTek RAID Manager software
automatically creates logical drives by grouping together same-sized physical disk
drives, and assigns RAID levels based on the number of physical disk drives in a
logical drive:

m A logical drive with three or more physical disk drives is assigned RAID 5.
m A logical drive with two physical disk drives is assigned RAID 1.

m A logical drive with only a single physical disk drive becomes a simple volume,
which does not offer redundancy.

Note — To create a logical drive with any other RAID level, you must use the custom
method, as described in “Custom Configuration (Advanced)” on page 40. See
“Selecting the Best RAID Level” on page 177 for more information about RAID
levels.

By default, logical drive size is set by the Sun StorageTek RAID Manager software
and automatically maximizes the capacity of the disk drives. However, you can
choose to specify a size for a logical drive, if required.
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V¥ To Build a Storage Space With the Express
Method

1. In the Enterprise View, select the HBA you want.

2. On the toolbar, click Create.

File Wiew Remote Actions Help

B o s
g

Enterprise view

3. When the wizard opens, select Express configuration..., then click Next.

4. Review the information that is displayed.

Note — Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.

Chapter 4 Building a Storage Space 37



FIGURE 4-1 Configuration Summary

Configuration summary. Below is the configuration summary for the controller. To accept and save this
configuration, click Bpply.' To make changes, click the "Modify' button.

Configuration summany 1
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@ RAID & TTAT GE Build £ Mo

L Modify logical devices ]

L < Back ]L Apphy ] L Cancel 1 [ Help ]

To exclude specific disk drives, specify a size for the logical drives, or to make
other changes to the configuration, click Modify logical devices. See Step 6 for
more information.

Note — Some operating systems have size limitations for logical drives. Before you
save the configuration, verify that the size of the logical drive is appropriate for your

operating system.

5. Click Apply, then click Yes.

The Sun StorageTek RAID Manager software builds the logical drive(s), indicated
by a magnifying glass moving across the new logical drive icon in the Logical
Devices View. The configuration is saved on the Sun StorageTek SAS RAID HBA

and on the physical drives.
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FIGURE 4-2 Logical Device Icons

Lomcatdmnces
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] has been created.

Note — To stop the creation of a new logical drive, right-click on the magnifying
glass icon, then choose Stop current task. You can also change the priority of the
build task to High, Medium, or Low by choosing Change background task priority
from the same right-click menu.

FIGURE 4-3 Stopping Current Task
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6. Repeat Step 1 to Step 5 for each HBA on your system.

7. If you want to assign hot-spares to the logical drives, see “Working With Hot-
Spares” on page 87.

8. Continue with “Partitioning and Formatting Logical Drives” on page 39.
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Partitioning and Formatting Logical Drives

The logical drives you create are displayed as physical disk drives on your operating
system. You must partition and format these logical drives before you can use them
to store data.

Note — Logical drives that have not been partitioned and formatted cannot be used
to store data.

Refer to your operating system documentation for more information.

Including More Systems In the Storage Space

Note — The Sun StorageTek RAID Manager software must be installed on every
system that will be part of your storage space.

If you have installed Sun StorageTek SAS RAID HBAs on more than one system, to
continue building your storage space do the following;:

m From each individual system, log into the Sun StorageTek RAID Manager
software and repeat Step 1 to Step 8 to continue building the storage space, or

m From the local system (the system you're working on), log in to all other systems
in your storage space as remote systems (see “Logging Into Remote Systems” on
page 53), then repeat Step 1 to Step 8 to continue building your storage space.

The maximum number of supported RAID HBAs varies depending on your
operating system. See “Sun StorageTek SAS RAID HBA Support” on page 51 for
more information.

To continue, see “Managing Your Storage Space” on page 52.

Custom Configuration (Advanced)

Custom configuration helps you build your storage space manually by stepping you
through the process of creating logical drives, setting RAID levels, and configuring
other settings.
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V¥ To Build the Storage Space With Custom
Configuration

1. In the Enterprise View, click the HBA you want.

Note how many available disk drives are connected to the HBA; this information
will be helpful as you create logical drives.

2. On the toolbar, click Create.

FIGURE 4-4 Create Button
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Enterprise view

3. When the wizard opens, select Custom configuration..., then click Next.

4. Select a RAID level.

The most common RAID levels are listed first; advanced RAID levels are available
by clicking Advanced settings.
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FIGURE 4-5 Selecting a RAID Level

Diefine logical devices. Follow the instructions in the panel below to select a RAID level, add physical drives,
and adjust other settings as desired. Click '"Add logical device'to define another, ar click 'Remove logical
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0

( Selectthe RAID level for this [ogical device.

i@ RAID D (Striping, 2 or mare drives required, not redundant)
i@ RAID 1 (Mirraring, 2 drives required, redundant)
RAID 5 (Striping with parity, 3 or mare drives reguired, redundant)

< Advanced settings

i@ RAID ME (Mirraring, 3 or mare drives reguired, redundant)
i@ RAID S5EE (Striping with parity, huil-in spare, 4 or moaore drives reguired, redundant)
i@ RAID 6 (Striping with dual parity, 4 or more drives reguired, redundanf)
i@ RAID 10 (Striped mirrars, even number of drives required, redundant)
i@ RAID 50 (RAID-5 groups striped together, & ar moaore drives reguired, redundant
i@ RAID 60 (RAID-6 groups striped together, 8 or more drives reguired, redundant
i@ Simple volume & single drive zegment, not redundant)
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| Add logical device | | <Back || Next> | [ cancel | | Help |

Note — To build a RAID Volume, see “Building a RAID Volume” on page 47. See
“Selecting the Best RAID Level” on page 177 for more information about RAID
levels.

5. Click Next.

6. In the Physical Devices panel, select the disk drives you want to use in the
logical drive.

Note — Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.
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The Sun StorageTek RAID Manager software prompts you to select the correct
number of disk drives. For example, the following figure illustrates disk drives

installed in a system.

FIGURE 4-6 Selecting Physical Devices for Logical Drive
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The following figure illustrates disk drives installed in two enclosures.
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FIGURE 4-7
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By default, the Sun StorageTek RAID Manager software automatically sets the size
of the logical drive and maximizes the capacity of the disk drives you select. (To set

— Create Global Hot
Spare button

a custom size for the logical drive, see Step 8.)

7. (Optional) If you want to assign hot-spares to the logical drives, see “Working

With Hot-Spares” on page 87.

A plus sign (+) is displayed to indicate that the selected drive will be designated
as a hot-spare, as shown below. To remove a hot-spare designation from a disk

drive, control-click it again.
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FIGURE 4-8 Hot-Spare Drives
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See “Working With Hot-Spares” on page 87 for more information.

8. (Optional) Adjust the Advanced Settings:

= To set a smaller logical drive size—Click Advanced Settings, then enter a size

for the logical drive in the Size GB box. Available space will remain on the

selected disk drives. See “Understanding Logical Drives” on page 67 for more

information.

= To modify other settings—Click Advanced Settings and customize the settings

as required. See “Fine-Tuning Logical Drives” on page 73 for more information.

9. If you have no other available disk drives, skip to Step 11.

If you have available disk drives and want to create additional logical drives,

click Add logical device to open a new tab

FIGURE 4-9 Tab for the Second Logical Drive
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10. Repeat Step 4 to Step 9 for each logical drive that you want to create on the
HBA.

11. Click Next, then review the logical drive settings.
This example shows two logical drives with RAID 5 are ready to be created.

FIGURE 4-10 Review Logical Drive Settings

Configuration summary, Below is the confiaguration summary for the controller. To accept and save this
configuration, click Apply' To make changes, click 'Back.

Configuration summany j

—) Click 'mpply' to save your configuration changes.

Logical device Size Initialization Hot spare
RAID & R24 67 GEB Build Yes
@ RAID & 238,574 GB Build es

L <« Back ]L Apphy ] L Cancel 1 [ Help ]

To make changes, click Back.

Note — Some operating systems have size limitations for logical drives. Before
continuing, verify that the size of the logical drive is appropriate for your operating
system. For more information, refer to your operating system documentation.

12. Click Apply, then click Yes.

The Sun StorageTek RAID Manager software builds the logical drive(s), indicated
by a magnifying glass moving across the new logical drive icon in the Logical
Devices View. The configuration is saved on the Sun HBA and on the physical
drives.
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FIGURE 4-11 Logical Device Icons

¥
Lodpical denvices

A magmifying glass means that

a logical drive is being built.

It disappears once the logical drive
has been created.

13. Repeat Step 1 to Step 12 for each HBA on the system.

14. Partition and format the logical drives.
See “Partitioning and Formatting Logical Drives” on page 39 for more
information.

If your storage space comprises one or more HBAs on a single system, building is
complete. Continue with “Managing Your Storage Space” on page 52.

If you have installed HBAs on more than one system and wish to add them to your
storage space, continue with “Including More Systems In the Storage Space” on
page 46.

Including More Systems In the Storage Space

Note — The Sun StorageTek RAID Manager software must be installed on every
system that will be part of your storage space.

If you have installed HBAs on more than one system, to continue building your
storage space:

m From each individual system, log into the Sun StorageTek RAID Manager
software and repeat Step 1 to Step 14 to continue building your storage space.

Or:

m From the local system, log in to all the other systems as remote systems (see
“Logging Into Remote Systems” on page 53), then repeat Step 1 to Step 14 to
continue building your storage space.

The maximum number of supported Sun StorageTek SAS RAID HBAs varies
depending on your operating system. See “Sun StorageTek SAS RAID HBA
Support” on page 51 for more information.

When your storage space is complete, continue with “Managing Your Storage Space”
on page 52.
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Building a RAID Volume

A RAID Volume comprises two or more logical drives connected end-to-end. The
logical drives in a RAID Volume must meet the following requirements:

m They must be built using disk drives connected to the same HBA.
m They have the same RAID level assigned.
m They must not be striped together.

m They may have equal or different capacities.

V¥ To Build a RAID Volume

1. Create two or more logical drives that meet the requirements listed at the
beginning of this section, and wait for them to build and initialize.

For instructions, see “Express Configuration: Building the Easy Way” on page 36
or “Custom Configuration (Advanced)” on page 40.

The following figure shows two example RAID 5 logical drives.

FIGURE 4-12 RAID 5 Logical Drives
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2. On the toolbar, click Create.
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3. When the configuration wizard opens, select Custom configuration..., then click

Next.

4. Click Advanced settings, select RAID Volume, then click Next.

5. In the Logical Devices panel, select the logical drives you want to use in the

RAID Volume.

The Sun StorageTek RAID Manager software prompts you to select the correct

number of logical drives.

FIGURE 4-13 Required Number of Logical Drives
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6. Modify the Advanced Settings, if required.

See “Fine-Tuning Logical Drives” on page 73 for more information.

7. Click Next to review the RAID volume settings.

To make changes, click Back.

The following figure shows an example RAID volume ready to be created.
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FIGURE 4-14 RAID Volume Configuration Summary

Configuration summary. Below is the configuration sumimary for the controller. To accept and save this
configuration, click Bpply' To make changes, click 'Back!
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8. Click Apply, then click Yes.

The Sun StorageTek RAID Manager software builds the RAID Volume. The
configuration is saved on the Sun StorageTek SAS RAID HBA and on the physical
drives. The Sun StorageTek RAID Manager software replaces the individual

logical drives with a single RAID Volume in the Logical Devices View.

FIGURE 4-15 Logical Devices View
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9. Partition and format your RAID Volume.

See “Partitioning and Formatting Logical Drives” on page 39 for more
information.

Sun StorageTek SAS RAID HBA Support

The maximum number of Sun StorageTek SAS RAID HBAs supported by the Sun
StorageTek RAID Manager software varies, depending on your operating system:

m Windows—Up to 16 Sun StorageTek SAS RAID HBAs
m Linux—Up to 12 Sun StorageTek SAS RAID HBAs

Note — For the most recent operating system support information, visit
http://support.intel.com/support/go/sunraid.htm.

Managing Your Storage Space

Once your storage space is built, you can add systems, HBAs, and disk drives to
meet your changing needs, then create logical drives by repeating the steps in this
chapter.

To customize the Sun StorageTek RAID Manager software and make managing your
storage space easier and more effective, continue with “Customizing the Software”
on page 53.

To learn how to monitor, manage, and modify your storage space, see these chapters
in the rest of this document:

m “Managing Logical Drives and Hot-Spares” on page 67

m “Monitoring Storage Space” on page 95

m “Managing Tasks” on page 123

m “Working with Display Groups” on page 133

m “Managing HBAs, Disk Drives, and Enclosures” on page 139

m “Troubleshooting” on page 159

To find the most commonly asked-about information, see “Frequently Asked
Questions” on page 189.
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For help identifying features of the Sun StorageTek RAID Manager software, see
“Buttons and Icons At-a-Glance” on page 201.
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CHAPTER 5

Customizing the Software

This chapter describes how you can customize the Sun StorageTek RAID Manager
software to make managing your storage space easier and more effective. All tasks
described in this chapter are optional. The chapter contains the following sections:

m “Logging Into Remote Systems” on page 53
m “Creating Display Groups” on page 56
m “Setting Preferences and Changing Views” on page 59

m “Customizing the Agent” on page 61

Logging Into Remote Systems

If multiple systems on the network are in your storage space, you can use the Sun
StorageTek RAID Manager software to monitor and manage all of them from one
system.

The system that you are working on is called the local system. All other systems in
the storage space are remote systems. ‘Local’ and ‘remote” are relative terms, as
shown in the following figure—when you are working on system A (local system),
system B is a remote system; when you are working on system B (local system),
system A is a remote system.
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FIGURE 5-1 Local and Remote System Configurations
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To manage remote systems from the local system, you log into the remote systems.

(The Sun StorageTek RAID Manager software encrypts the user name and password
of a remote system during log-in.) The Sun StorageTek RAID Manager software or

the Sun StorageTek RAID Manager Agent (see “Starting the Agent Only” on

page 17) must be running on these remote systems before you can log into them.

When you log into a remote system, you add that system to the Enterprise View of
the Sun StorageTek RAID Manager software, as shown in this example.

Sun StorageTek RAID Manager Software User’'s Guide ¢ May 2009



FIGURE5-2 Identifying Local and Remote Systems in the Enterprise View
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Once you have logged into a remote system, it is automatically included in the
Enterprise View each time you start the Sun StorageTek RAID Manager software
from the local system. You can work with the remote system’s HBAs, disk drives,
and logical drives as if they were part of your local system. You must log in with the
proper permission level to complete the tasks you wish to perform. (See
“Understanding Permission Levels” on page 20 for more information.)

V¥ To Log Into a Remote System

1. From the menu bar, click Remote, then select Add.
The Add Managed System window is displayed.
2. Ensure that Managed System (Internal RAID) is selected in the Type drop-
down menu, then enter the Host name or TCP/IP address of the remote system.
3. Enter the startup port number of the remote system.
The default port number is 34571.

4. If prompted, enter your user name and password.
(User names and passwords are case-sensitive.) To save this user name and
password, select the Save user name/password box.

5. Click Connect.
The Sun StorageTek RAID Manager software connects to the remote system and
adds it to the list of managed systems in the Enterprise View.

6. To manage the remote system, select it in the Enterprise View and enter your
user name and password if prompted.

To create logical drives on remote systems, see “Building a Storage Space” on
page 35.
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V¥ To Remove a Remote System

If you no longer want to monitor a remote system, you can remove it from the
Enterprise View.

Removing a remote system does not cause it to fail.

1. In the menu bar of the main window, choose Remote > Remove managed
system > remote-system-name.
The Remove Managed System window is displayed.

2. If you want to continue receiving events from the remote system after it has

been removed from the local system, select Continue to receive events from the
remote system from the drop-down menu.

3. Click OK.

The remote system is removed from the Enterprise View of the Sun StorageTek
RAID Manager software.

Creating Display Groups
You can organize related local and remote systems into display groups to make

managing your storage space easier and more effective.

Systems in a display group are displayed together in the Enterprise View under the
group name.

V¥ To Create a Display Group

1. In the Enterprise View, right-click on a system that you want to add to a display
group
A navigational menu is displayed.

2. Choose Change display group > New group.
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FIGURE 5-3 Creating a New Display Group
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3. Enter a name for the new display group, then click OK.
The display group is created and the system you selected in Step 1 is added to it.

FIGURE 5-4 Viewing The Display Groups
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4. To add another system to the newly created display group, right-click on the
system in the Enterprise View, choose Change display group > group-name.
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FIGURE 5-5 Changing the Display Group
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The system is added to the new display group.

FIGURE5-6 Viewing Systems Within a Display Group
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Display groups are sorted alphabetically and are displayed in the Enterprise View
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below any systems that are not part of a display group.

A system can belong to only one display group at a time; you can’t include the same

system in multiple display groups.

For more information, see “Working with Display Groups” on page 133.
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Setting Preferences and Changing Views

You can customize the Sun StorageTek RAID Manager software by doing the
following;:

m Sorting the systems in the Enterprise View (see the following section).

m Selecting the standard unit of measure shown for disk drives (see “To Change the
Standard Unit of Measure” on page 60).

m Excluding the tool bar or status bar from the main window, or turning off the Tool
Tips (see “To Change the Main Window Appearance” on page 61).

To Sort Systems in the Enterprise View

You can set the Sun StorageTek RAID Manager software to sort systems in the
Enterprise View alphabetically or chronologically. By default, systems are listed in
alphabetical order. The local system always appears first when you sort objects
alphabetically.

1. In the menu bar of the main window, choose File > Preferences.
2. Click the Display options tab.

3. In the System tree sorting drop-down menu, select the option you want.
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FIGURE 5-7 Sorting Systems in the Enterprise View
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4. Click OK.

V¥ To Change the Standard Unit of Measure

You can set the Sun StorageTek RAID Manager software to show disk drive capacity
in measures of megabytes (MB), gigabytes (GB), or terabytes (TB).

You can choose the Auto-select setting to allow the Sun StorageTek RAID Manager
software to show the most appropriate unit of measure based on disk drive size.
This option allows different disk drives to be shown in different units of measure.

By default, disk drives are shown in GB.
1. In the menu bar of the main window, choose File > Preferences.
2. Click the Display options tab.

3. In the Capacity display units drop-down menu, select the option you want.
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FIGURE 5-8 Changing the Standard Unit of Measure
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4. Click OK.

V¥ To Change the Main Window Appearance

You can choose to remove the tool bar and status bar from the main Sun StorageTek
RAID Manager software window to save space on-screen. You can also choose to
turn off the Tool Tips that automatically appear when you place your cursor over on-
screen items.

® In the menu bar, select View.

The options in the View menu are toggle switches, which means that they can be
selected and deselected by clicking on them.

Customizing the Agent

The default settings of the Sun StorageTek RAID Manager Agent are suitable for
most storage spaces. (See “About the Agent” on page 3 for more information.)
However, you can customize the Agent on any system by doing the following;:

m Setting the Agent to broadcast events on that system to all logged-in users. See
“Broadcasting Event Alerts From a System” on page 62.
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m Changing the operating system event log setting for that system. See “To Change
or Disable OS Event Logging On a System” on page 62.

m Changing the frequency and duration of the alarm, or choose to disable the alarm
for that system. See “To Change Alarm Settings On a System” on page 63.

m Changing to Agent base port number on that system. See “To Change the Agent
Base Port Number On a System” on page 65.

Any changes you make to the Agent settings affect the selected system only and are
not applied to all systems in your storage space.

Broadcasting Event Alerts From a System

You can set the Sun StorageTek RAID Manager Agent to send event alerts about a
specific system to all users who are logged into your storage space network. You
might want to do this if your storage space isn’t managed by a dedicated person, or
if that particular system is off-site or isn’t connected to a monitor.

Event alerts signal to everyone working on the storage space that technical
assistance is required for that system.

For more information, see “Broadcasting Event Alerts to Users” on page 117.

V¥ To Change or Disable OS Event Logging On a
System

By default, all Warning- and Error-level events on a system are recorded in the
operating system event log. You can customize the level of events that are recorded,
or you can disable operating system event logging.

1. In the Enterprise View, select the system.

2. Click the Configure button, then choose General Settings.
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FIGURE 5-9 Changing the Agent’s General Settings
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The Agent General Settings window is displayed.

3. From the Save events to OS log drop-down menu, choose the type of event

logging that you want, then click Save changes.

FIGURE 5-10 Agent General Settings Window
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4. Restart the Sun StorageTek RAID Manager software to apply the new setting.

V¥ To Change Alarm Settings On a System

Warning- and Error-level events on a system (see “About the Status Icons” on
page 98) trigger an audible alarm, a series of beeps which sound every five minutes

until the event is resolved.
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You can change the frequency and duration of the alarm, or choose to disable the
alarm on any system. For information about using the audible alarm, see “Silencing
and Testing the Audible Alarm” on page 120.

1. In the Enterprise View, select the system.

2. Click the Configure button, then click General Settings.

The Sun StorageTek RAID Manager Agent General Settings window is displayed
for the system you selected.

FIGURE 5-11 Editing Alarm Settings on the Agent General Settings Window
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3. Edit the alarm settings as required.

(Select or deselect Sound alarm; change the Alarm interval (Seconds) time.)

when a Warning- or Error-level event occurs.

iii Caution — If you disable the alarm, no audible signal will sound on that system
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4. Click Save changes.

5. Restart the Sun StorageTek RAID Manager software to apply the new settings.
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V¥ To Change the Agent Base Port Number On a
System

The Sun StorageTek RAID Manager software uses six consecutive ports to access
remote systems: 34571, 34572, 34573, 34574, 34575, and 34576. The default port
number for the Agent is 34571. If your system has a conflict with these ports, change
the base port to a different port number.

V¥ To Change the Agent Base Port Number

1. In the Enterprise View, select the system.

2. Click the Configure button, then click General Settings.

The Sun StorageTek RAID Manager Agent General Settings window is displayed
for the system you selected.

3. Enter a new Agent system base port number.
4. Click Save changes.

5. Restart the Sun StorageTek RAID Manager software and the Sun StorageTek
RAID Manager Agent to apply the new setting.
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CHAPTER 6

Managing Logical Drives and Hot-
Spares

This chapter explains how to manage logical drives and hot-spares associated with
RAID host bus adapters (HBAs). For detailed information about creating a logical
drive, see “Building a Storage Space” on page 35.

The chapter contains the following sections:

m “Understanding Logical Drives” on page 67

m “Creating Logical Drives” on page 69

m “Fine-Tuning Logical Drives” on page 73

m “Verifying Logical Drives” on page 77

m “Increasing the Capacity of a Logical Drive” on page 80

m “Changing the RAID Level of a Logical Drive” on page 83

m “Deleting a Logical Drive” on page 86

m “Working With Hot-Spares” on page 87

Understanding Logical Drives

A logical drive is a group of physical disk drives that appears to your operating
system as a single drive that can be used for storing data.

A logical drive can comprise one or more disk drives and can use part or all of each
disk drive’s capacity.

It is possible to include the same disk drive in two different logical drives by using
just a portion of the space on the disk drive in each, as shown in the following
figure.
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FIGURE 6-1 How Physical Drives Are Used for Logical Drives
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Disk drive space that has been assigned to a logical drive is called a segment. A
segment can include all or just a portion of a disk drive’s space. A disk drive with
one segment is part of one logical drive, a disk drive with two segments is part of
two logical drives, and so on. A segment can be part of only one logical drive. When
a logical drive is deleted, the segments that comprised it revert to available space (or
free segments).

A logical drive can include redundancy, depending on the RAID level assigned to it.
(See “Selecting the Best RAID Level” on page 177 for more information.)

Once a logical drive has been created, you can change its RAID level or increase its
capacity to meet changing requirements. You can also protect your logical drives by
assigning one or more hot-spares to them. (See “Working With Hot-Spares” on
page 87 for more information.)

Creating Logical Drives

For basic instructions for creating logical drives, see “Building a Storage Space” on
page 35.
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This section describes three additional scenarios for creating logical drives:
m Setting the size of a new logical drive (see the following section)

m Including different-sized disk drives in a logical drive (see “Including Different-
Sized Disk Drives in a Logical Drive” on page 70)

m Creating a logical drive using available segments of disk drives (see “To Create a
Logical Drive Using Free Segments on Disk Drives” on page 71)

To Set the Size of a Logical Drive

The Sun StorageTek RAID Manager software automatically sets the size of a new
logical drive to maximize the capacity of the disk drives that it comprises. However,
you can choose to set the size for a new logical drive. You may want to do this to
maximize the available disk drive space, or allocate available space to more than one
logical drive.

1. Complete Step 1 through Step 6 in “Custom Configuration (Advanced)” on
page 40.

2. Click Advanced Settings.

The maximum size of the logical drive appears in the Size (GB) box.

3. Enter the new size for the logical drive.

The size you enter must be less than or equal to the maximum size.
4. Click Next.
5. Review the logical drive settings, click Apply, then click Yes.

The Sun StorageTek RAID Manager software builds the logical drive. The
configuration is saved in the Sun HBA and in the physical drives.

If the disk drives you used to create this logical drive have available space left over,
you can use them to create a new logical drive (see “To Create a Logical Drive Using
Free Segments on Disk Drives” on page 71), or to expand an existing logical drive
(see “Increasing the Capacity of a Logical Drive” on page 80).

Including Different-Sized Disk Drives in a Logical
Drive

You can combine disk drives of different sizes in the same logical drive. If the logical
drive includes redundancy, however, the size of each segment can be no larger than

the size of the smallest disk drive. (See “Selecting the Best RAID Level” on page 177
for more information about redundancy.)
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Note — Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.

To create a logical drive with disk drives of different sizes, follow the instructions in
“Building a Storage Space” on page 35. When the logical drive is created, it is
displayed in a similar fashion to the following example. In this example, a RAID 5
logical drive includes two 16.95 GB disk drives and two 9.77 GB disk drives.

FIGURE 62 RAID 5 Logical Drive
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o Port7-Hot spare (3.77 GE)

The Full Size Capacity View of the same RAID 5 logical drive shows that the two
larger disk drives still have available space (free segments are indicated in light-
blue) that is not part of a logical drive.
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FIGURE 6-3 RAID 5 in Full Size Capacity View
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You can include the available space on a disk drive in a new logical drive (see “To
Create a Logical Drive Using Free Segments on Disk Drives” on page 71), or add it to
an existing logical drive (see “Increasing the Capacity of a Logical Drive” on

page 80).

To Create a Logical Drive Using Free Segments
on Disk Drives

Free segments on a disk drive can be used to create a new logical drive. (A segment
can only be used in one logical drive at a time.)

1. Complete Step 1 through Step 5 in “Custom Configuration (Advanced)” on
page 40.

2. In the Physical Devices panel, select the disk drives and/or free disk drive
segments you want to use in the logical drive.

Note — Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.
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In this example, two free disk drive segments (indicated in blue) are used to create a
RAID 1 logical drive.

FIGURE 6-4 RAID 1 Logical Drive

Define logical devices. Follow the instructions in the panel below to select a RAID level, add physical drives, and
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3. Click Next.
4. Review the logical drive settings.

5. Click Apply, then click Yes.

The Sun StorageTek RAID Manager software builds the logical drive. The
configuration is saved in the Sun StorageTek SAS RAID HBA and in the physical
drives.
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Fine-Tuning Logical Drives

You can fine-tune a new or existing logical drive to meet your needs by changing its
name or adjusting the Advanced settings described in this section. (Not all options
are available for all HBAs or all RAID levels.)

To Change The Name of a Logical Drive

1. In the Enterprise View, click the HBA associated with the logical drive.

2. In the Logical Devices View, click the logical drive.

3. In the menu bar, choose Actions > Change logical device name.

FIGURE 6-5 Renaming a Logical Drive
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4. Type the new name, and click OK.

The logical drive is updated with its new name.
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V¥ To Change the Advanced Settings of a Logical
Drive

Note — The default settings in the Sun StorageTek RAID Manager software are
optimal for most users and storage spaces. Do not change the settings described in
this section if you are not an advanced user.

1. Open the list of Advanced settings.
2. If you are creating a new logical drive, follow the instructions in Step 6.
3. If you are modifying an existing logical drive do the following:
a. In the Enterprise View, click the HBA associated with the logical drive.
b. In the Logical Devices View, click the logical drive.
c. In the menu bar, choose Actions > Expand or change logical device .
d. Click Next, then click Advanced settings.

4. Modify the available settings as required for your logical drive (not all options
are available for all HBAs or all RAID levels):
» Logical drive size (see “To Set the Size of a Logical Drive” on page 69)
n Stripe size (see “Changing the Stripe Size” on page 74)
n  Write cache (see “Changing the Write Cache Setting” on page 75)
m Read cache (see “Changing the Read Cache Setting” on page 75)
» Initialize priority (see “Changing the Initialize Priority” on page 76)
» Initialize method (see “Changing the Initialize Method” on page 76)

5. Click Next.

6. To apply the changes immediately, click Apply.

To schedule the changes for later, click Schedule, then set the date and time. (For
more information, see “Scheduling a Task” on page 123.)

Changing the Stripe Size

The stripe size is the amount of data (in KB) written to one partition before the HBA
moves to the next partition in a logical drive.

Stripe size options vary, depending on your HBA. Normally, the default stripe size
provides the best performance.
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For RAID 6 and RAID 60 logical drives, the more disk drives there are in the logical
drive, the fewer the stripe size options.

Changing the Write Cache Setting

The write cache setting determines when data is stored on a disk drive and when the
HBA communicates with the operating system.

m Disabled (write-through)—The HBA sends (or writes) the data to a disk drive,
then sends confirmation to the operating system that the data was received. Use
this setting when performance is less important than data protection.

m Enabled (write-back)—The HBA sends confirmation to the operating system that
the data was received, then writes the data to a disk drive. Use this setting when
performance is more important than data protection and you aren’t using a
battery-backup cache. Enabled is the default setting.

Note — (RAID 10, 50, and 60 only) All logical drives within a RAID 10/50/60 logical
drive must have the same write cache setting—either all write-through or all write-
back.

V¥ To Change the Write Cache Setting

1. Click the logical drive you want.
2. In the menu bar, choose Actions > Configure write cache > Enabled or
Disabled, as required.

The write cache setting is changed.

Changing the Read Cache Setting

When read caching is enabled, the HBA monitors the read access to a logical drive
and, if it sees a pattern, pre-loads the cache with data that seems most likely to be
read next, increasing performance.

m Enabled—The HBA transfers data from the logical drive to its local cache in
portions equal to the stripe size. Use this setting for the best performance when
workloads are steady and sequential. Enabled is the default setting.
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m Disabled—The HBA transfers data from the logical drive to its local cache in
portions equal to the system I/O request size. Use this setting for the best
performance when workloads are random or the system I/O requests are smaller
than the stripe size. (For more information about system 1/O requests, refer to
your operating system documentation.)

V¥ To Change the Read Cache Setting

1. Click the logical drive you want.
2. In the menu bar, choose Actions > Configure read cache > Enabled or
Disabled,as required.

The read cache setting is changed.

Changing the Initialize Priority

The Initialize Priority setting determines the priority for the initialization of the
logical drive. The default setting is High, which means that the logical drive is
initialized as quickly as possible.

Changing the Initialize Method

The Initialize Method setting determines how a logical drive is initialized (prepared
for reading and writing), and how long initialization will take. The settings are
presented in order of slowest to fastest method.

m Build—(slowest) For RAID 1 logical drives, data is copied from the primary drive
to the mirror drive; for RAID 5 logical drives, parity is computed and written.
Build is the default setting for most logical drives (see the Quick method below).

The Sun StorageTek RAID Manager software performs build initialization in the
background; you can use the logical drive immediately.

m Clear—Every block in the logical drive is overwritten, removing all existing data.
You can’t use the logical drive until the initialization is complete.

m Quick—(fastest) The logical drive is made available immediately. Quick is the
default setting for RAID 1, RAID 1EE, and RAID 10 logical drives.
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Veritying Logical Drives

To ensure that there are no data problems on your logical drives, it is important to
verify them. When you verify a logical drive, the Sun StorageTek RAID Manager
software checks it for inconsistent or bad data and then fixes any problems. (You can
also choose to verify a logical drive without fixing it.)

Logical drives with no redundancy (for instance, RAID 0 logical drives) do not need
to be verified.

In the Sun StorageTek RAID Manager software, logical drive verification can occur
like so:

m Automatic verification—If your HBA supports build initialization, the Sun
StorageTek RAID Manager software automatically verifies all new redundant
logical drives. No manual verification is required.

V¥ To Confirm That the HBA Supports Build
Initialization

Right-click the HBA in the Enterprise View and click Properties.

m Manual verification—If your HBA doesn’t support build initialization, a
Warning-level event notice is displayed in the Event Viewer prompting you to
verify a logical drive before you begin to use it. To verify a logical drive manually,
see “To Verify and Fix a Logical Drive” on page 78.

m Background verification—If your HBA supports background consistency check,
the Sun StorageTek RAID Manager software continually and automatically checks
your logical drives once they’re in use.

V¥ To Confirm That the HBA Supports Background
Consistency Checking

® Right-click the HBA in the Enterprise View, then click Properties.

To enable or disable background consistency check, see “To Enable or Disable
Background Consistency Checking” on page 80.
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Note — If your HBA doesn’t support background consistency checking, verify its
logical drives weekly. Follow the instructions in “To Verify and Fix a Logical Drive”
on page 78.

To Verity and Fix a Logical Drive

Note — To verify a logical drive without fixing it, see “To Verify a Logical Drive
Without Fixing It” on page 79.

While the Sun StorageTek RAID Manager software verifies and fixes a logical drive,
you can’t complete any other tasks on the HBA. Because the verification can take a
long time to complete, you may want to schedule it as a task to be completed
overnight or on a weekend.

1. In the Enterprise View, click the HBA associated with the logical drive.
2. In the Logical Devices View, click the logical drive.

3. In the menu bar, choose Actions, > Verify with fix.
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4. To begin the verification immediately, click Yes.

To schedule the verification, click Schedule, then set the date and time. You can
also choose to set the verification as a recurring task. (For more information, see
“Scheduling a Task” on page 123.)
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Note — Don’t power off the system while the verification is in progress. If you do,
the verification will stop.

While the verification is in progress, the logical drive is shown as an
@ animated icon to indicate that the task is in progress.

When the verification is complete, an event notice is generated in the local
system’s event log (and broadcast to other systems, if you have event notification set
up—see “Using Notifications to Monitor Status” on page 99).

You can now continue working on the HBA.

To Verify a Logical Drive Without Fixing It

Note — To verify and fix a logical drive, see “To Verify and Fix a Logical Drive” on
page 78.

While the Sun StorageTek RAID Manager software verifies a logical drive, you
cannot complete any other tasks on the HBA associated with that logical drive.
Because verification takes a long time to complete, you may want to schedule it as a
task to be completed overnight or on a weekend.

1. In the Enterprise View, click the HBA associated with the logical drive.
2. In the Logical Devices View, click the logical drive.
3. In the menu bar, choose Actions > Verify.

4. To begin the verification immediately, click Yes.

To schedule the verification for later, click Schedule, set the date and time, then
click Apply. You can also set the verification to recur. (For more information, see
“Scheduling a Task” on page 123.)

Note — Do not power off the system while the verification is in progress. If you do,
the verification will stop. While the verification is in progress, the logical drive is
shown as an animated icon (as shown at right) to indicate that the task is in
progress.

While the verification is in progress, the logical drive is shown as an
animated icon. @
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When the verification is complete, an event notice is generated in the local system’s
event log (and broadcast to other systems, if you have event notification set up—see
“Using Notifications to Monitor Status” on page 99).

You can now continue working on the HBA.

V¥ To Enable or Disable Background Consistency
Checking

If your HBA supports background consistency checking, the Sun StorageTek RAID
Manager software continually and automatically checks your logical drives once
they’re in use. (To confirm that your HBA supports background consistency
checking, right-click the HBA in the Enterprise View, then click Properties.)

1. In the Enterprise View, click the HBA.

2. In the menu bar, choose Actions > Enable (Disable) background consistency
check.

The HBA is updated with the new setting.

Increasing the Capacity of a Logical
Drive

You can add more disk drive space to a logical drive to increase its capacity (or
expand it).

Note — The maximum size of a logical drive varies by HBA. Refer to your HBA's
documentation for more information.

The expanded logical drive must have a capacity that’s greater than or equal to the
original logical drive.

V¥ To Increase the Capacity of a Logical Drive

1. In the Enterprise View, click the HBA associated with the logical drive.

2. In the Logical Devices View, click the logical drive.
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3. In the menu bar, choose Actions > Expand or change logical device.

A wizard opens to help you modify the logical drive.

4. Click Next.

5. Click on the disk drive(s) or disk drive segments you want to add to the logical

drive.

Note — Do not combine SAS and SATA disk drives within the same logical drive.

The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.

FIGURE 6-6 Increasing the Capacity of a Logical Drive
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If you want to remove a specific disk drive or segment and replace it with another

one (for instance, replace a smaller disk drive with a larger one), click on the disk

drive you want to remove.

An X indicates that the selected disk drive will be removed from the logical drive,

and you are prompted to select another disk drive (of greater or equal size) to

replace it.
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FIGURE 6-7 Replacing a Device That is Part of a Logical Drive
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6. Modify the Advanced Settings, if required.

See “Fine-Tuning Logical Drives” on page 73.

7. Click Next.

8. Review the new logical drive settings.

To make changes, click Back.

Note — Some operating systems have size limitations for logical drives. Before you
save the configuration, verify that the size of the logical drive is appropriate for your

operating system.

9. To update the logical drive immediately, click Apply, then click Yes.

To schedule the changes for later, click Schedule, set the date and time, then click

Apply. (For more information, see “Scheduling a Task” on page 123.)
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Extending a Partition on a Logical Drive

(Windows 2003, Windows XP, and Windows 2000 only) If you have expanded a logical
drive, you can extend the partition on that logical drive to use the newly added
space. Refer to your operating system instructions for more information.

Changing the RAID Level of a Logical
Drive

As your requirements change, you can change the RAID level of your logical drives
to suit your needs. You may want to do this to add redundancy to protect your data,
or improve data availability for speedier access to your data. See “Selecting the Best
RAID Level” on page 177 for more information.

Changing the RAID level normally requires one or more disk drives to be added to
or removed from the logical drive. The Sun StorageTek RAID Manager software
won'’t allow you to continue unless you have the right number of disk drives
available.

To Change the RAID Level of a Logical Drive

1. In the Enterprise View, click the HBA associated with the logical drive.
2. In the Logical Devices View, click the logical drive.

3. In the menu bar, choose Actions > Expand or change logical device.

A wizard opens to help you change the RAID level.

4. Select a new RAID level, then click Next.
Only valid options are offered.

In the following example, a RAID 1 logical drive is being changed to a RAID 5
logical drive.
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FIGURE 6-8 Changing the RAID Level of a Logical Drive
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5. In the Logical Devices panel, select the disk drives you want to use in the
modified logical drive.

Note — Do not combine SAS and SATA disk drives within the same logical drive.
The Sun StorageTek RAID Manager software generates a warning if you try to create
a logical drive using a combination of SAS and SATA disk drives.

The Sun StorageTek RAID Manager software prompts you to select the correct
number of disk drives. In the following example, you must select three disk drives.
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FIGURE 6-9 Choosing the Correct Number of Devices for a Logical Drive
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instance, replace a smaller disk drive with a larger one), click on the disk drive you

want to remove. An X indicates that the selected disk drive will be removed from

the logical drive.

6. Modify the Advanced Settings, if required.

See “Fine-Tuning Logical Drives” on page 73.

7. Click Next.

8. Review the new logical drive settings.

To make changes, click Back.

Note — Some operating systems have size limitations for logical drives. Before you
save the configuration, verify that the size of the logical drive is appropriate for your

operating system.

9. To update your logical drive immediately, click Apply, then click Yes.

To schedule the changes for later, click Schedule, set the date and time, then click

Apply. (For more information, see “Scheduling a Task” on page 123.)
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Deleting a Logical Drive

Caution — When you delete a logical drive, you lose all data stored on that logical
drive.

To Delete a Logical Drive

1. Ensure that you no longer need the data stored on the logical drive.
2. In the Enterprise View, click on the HBA associated with the logical drive.
3. In the Logical Devices View, click the logical drive.

4. In the menu bar, choose Actions > Delete logical device.

FIGURE 6-10 Deleting a Logical Drive
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5. When prompted, click Yes to delete the device, or No to cancel the deletion.

If you click Yes, the logical drive is deleted. The disk drives or drive segments
included in the logical drive become available, and can be used to create a new
logical drive (see “To Create a Logical Drive Using Free Segments on Disk Drives”
on page 71), or to expand an existing logical drive (see “Increasing the Capacity of a
Logical Drive” on page 80).
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Working With Hot-Spares

A hot-spare is a disk drive that automatically replaces any failed drive in a logical
drive, and can subsequently be used to rebuild that logical drive. (For more
information on recovering from a disk drive failure, see “Recovering From a Disk
Drive Failure” on page 161.)

Hot-Spare Limitations

m You cannot create a hot-spare for RAID 0 logical drives, simple volumes, or
spanned volumes.

m You cannot create a hot-spare from a disk drive that is already part of a logical
drive.

m You must select a disk drive that is at least as big as the largest disk drive it might
replace.

m You cannot designate a SAS hot-spare for a logical drive comprising SATA disk
drives, or a SATA hot-spare for a logical drive comprising SAS disk drives.

Global Hot-Spare Versus Dedicated Hot-Spare

A global hot-spare is not assigned to a specific logical drive and will protect any
logical drive on the HBA (except RAID 0 logical drives). You can designate a global
hot-spare before or after you build logical drives on a HBA; you can also designate a
global hot-spare while you're creating a logical drive. To designate a global hot-
spare, see “To Designate a Global Hot-Spare” on page 88.

A dedicated hot-spare is assigned to one or more specific logical drives and will only
protect those logical drives. (A dedicated hot-spare that has been assigned to protect
more than one logical drive is called a pool spare.) You must create the logical drive
before you can assign a dedicated hot-spare. If you create the logical drive using the
BIOS utility, you must wait until the build is complete before you can assign a
dedicated hot-spare. To assign a dedicated hot-spare or pool hot-spare, see “To
Assign a Dedicated or Pool Hot-Spare” on page 89.

To Designate a Global Hot-Spare

This section describes how to designate a global hot-spare before or after you build
a logical drive.
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Note — To designate a global hot-spare while you are creating a logical drive, see
Step 6.

1. In the Enterprise View, click the HBA on which you want a global hot-spare.

2. In the Physical Devices View, click the disk drive you want to designate as a
hot-spare.

See “Hot-Spare Limitations” on page 87 for help selecting a disk drive.

3. Click the Create global hot-spare drive button.

hysical devices | l_l_ﬂgical devices

M Controller 1 @

thannel 0 {14 devices found) Logical devices {4] Create g global hot-spare drive
eceeceaa > 0.0 .0.0

A plus sign is displayed beside the selected disk drive, indicating that it’s
designated as a hot-spare. (A yellow plus sign indicates an error. See “About the
Hot-Spare Icons” on page 91 for help solving the problem.)

FIGURE 6-11 Identifying a Global Hot-Spare - The Icon With The Plus Sign Next To It
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Any other logical drives created on the HBA will automatically be protected by that
global hot-spare.
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V¥ To Assign a Dedicated or Pool Hot-Spare

A dedicated hot-spare is assigned to one or more specific logical drives. (A
dedicated hot-spare that has been assigned to protect more than one logical drive is
called a pool hot-spare.)

Note — You must create the logical drive before you can assign a dedicated hot-
spare. If you create the logical drive using the BIOS utility, you must wait until the
build is complete before you can assign a dedicated hot-spare.

1. In the Enterprise View, click the HBA on which you want a dedicated hot-
spare.

2. In the Physical Devices View, click the disk drive you want to designate as a
hot-spare.

See “Hot-Spare Limitations” on page 87 for help selecting a disk drive.

3. In the menu bar, choose Actions > Create dedicated hot-spare drive for > name-
of-the-logical-drive.

FIGURE 6-12 Creating a Dedicated Hot-Spare Drive
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A plus sign is displayed next to the selected disk drive, indicating that it is
designated as a dedicated hot-spare. (A yellow plus sign indicates an error. See
“About the Hot-Spare Icons” on page 91 for more information.)
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FIGURE 6-13 Identifying a Designated Hot-Spare

Channel 1 {14 devices found)

o
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4. To use the same dedicated hot-spare to protect another logical drive (create a
pool hot-spare), repeat Step 2 and Step 3.

About the Hot-Spare Icons

TABLE 6-1 Hot-Spare Icons

Icon Explanation

Healthy global or dedicated hot-spare

Error on hot-spare:

- ¢ Hot-spare is not assigned to any
|  logical drives

* Hot-spare is too small to protect the
logical drive(s) it’s assigned to

¢ Global hot-spare was designated
before any logical drives were built

Hot-spare has been built into a logical
drive after disk drive failure

Action

No action required.

* Create at least one logical drive on the
same HBA

® Designate larger disk drive as hot-spare

* Create at least one logical drive on the
same HBA

Designate replacement or other available
disk drive as new hot-spare; remove ‘hot-
spare’ designation from disk drive (see “To
Remove or Delete a Dedicated Hot-Spare”
on page 91)

V¥ To Remove or Delete a Dedicated Hot-Spare

You can delete a dedicated hot-spare or remove it from a logical drive. You may

want to do this to:

m Make disk drive space available for another logical drive.

m Make a dedicated hot-spare into a global hot-spare.
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m Remove the ‘hot spare” designation from a disk drive that is no longer being used

as a hot-spare. (When a hot-spare is built into a logical drive after a disk drive

failure, it retains its ‘hot spare” designation even though it can no longer protect
the logical drives it’s assigned to. See “Recovering From a Disk Drive Failure” on
page 161 for more information.)

1. In the Enterprise View, click the HBA associated with the hot-spare.

2. In the Physical Devices View, click the hot-spare.

3. In the menu bar, choose either of these options:

» Actions > Delete dedicated hot-spare drive > logical-drive-name

= Actions > Remove dedicated hot-spare drive from > logical-drive-name

FIGURE 6-14 Removing a Dedicated Hot-Spare Drive From a Logical Drive
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The hot-spare is deleted or removed, and the disk drive becomes available for

Channel 1 (14 devices found)
Do oG & O O O L

other uses in your storage space.

V¥ To Delete a Global Hot-Spare

You can delete a global hot-spare. You may want to do this to:

m Make disk drive space available for another logical drive.

m Make a global hot-spare into a dedicated hot-spare.
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m Remove the ‘hot spare” designation from a disk drive that is no longer being used
as a hot-spare. (When a hot-spare is built into a logical drive after a disk drive
failure, it retains its ‘hot spare” designation even though it can no longer protect
the logical drives it’s assigned to. See “Recovering From a Disk Drive Failure” on
page 161 for more information.)

1. In the Enterprise View, click the HBA associated with the hot-spare.
2. In the Physical Devices View, click the hot-spare.

3. In the menu bar, choose Actions > Delete hot-spare drive.

FIGURE 6-15 Deleting a Hot-Spare Drive
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The hot-spare is deleted and the disk drive becomes available for other uses in
your storage space.

V¥ To Enable Copyback

When a logical drive is rebuilt using a hot-spare (see “Failed Disk Drive Protected by
a Hot-Spare” on page 162), data from the failed drive is transferred to the hot-spare.

When copyback is enabled, data is moved back to its original location once the HBA

detects that the failed drive has been replaced. Once the data is copied back, the hot-
spare becomes available again. Copyback is disabled by default.

1. Right-click the HBA

2. Choose Enable or Disable copy back mode.
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CHAPTER 7

Monitoring Storage Space

This chapter describes how the Sun StorageTek RAID Manager software helps you
monitor your storage space. The chapter contains the following sections:

“Monitoring Options” on page 95

“Checking Activity in Your Storage Space” on page 96
“About the Status Icons” on page 98

“Using Notifications to Monitor Status” on page 99
“Broadcasting Event Alerts to Users” on page 117
“Managing Enclosure Status” on page 118

“Silencing and Testing the Audible Alarm” on page 120

Monitoring Options

The Sun StorageTek RAID Manager software provides many ways to monitor the
status of your storage space:

Event Viewer—The main window of the Sun StorageTek RAID Manager software
includes an Event Viewer that provides at-a-glance status information about
activity occurring in your storage space. (See “Checking Activity in Your Storage
Space” on page 96.)

Status Icons—Three basic icons (information, warning, and error) appear in the
Event Viewer and in the main Sun StorageTek RAID Manager software window
to help you quickly identify problems. (See “About the Status Icons” on page 98.)

Notification Manager and Email Notification Manager—Notification utilities
help you monitor these activities on local and remote systems (see “Setting Up
Event Notifications” on page 99 and “Setting Up Email Notifications” on

page 108):

» Progress of scheduled tasks, such as logical drive verifications.
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» Changes in the status of the physical components of your storage space, such
as disk drives.

» Changes to the local system, such as the expansion of a logical drive expansion
or the creation of a hot-spare.

m Audible Alarm—A series of beeps sounds whenever a serious event occurs on
your storage space. (See “Silencing and Testing the Audible Alarm” on page 120.)

m Properties Button—You can check the status of any component in your storage
space by using the Properties button. (See “Viewing Component Properties” on
page 139.)

Checking Activity in Your Storage Space

From the local system, you can see status information and messages about the
activity (or events) occurring in your storage space.

V¥ To View the Full List of Events

® To open a full-screen version of the event log, go to the Event Viewer by
clicking the Events button.

You can sort the events by clicking the column heads.

V¥ To View Event Details

1. From the Event Viewer, review the log of events.

Status is indicated by an icon in the left-hand column. The icons are described in
“About the Status Icons” on page 98.

2. Double-click an event to see more details about the event.

The Configuration event detail window is displayed.
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3. From the Configuration event detail window, click Next to see the next event in
the list.

You can monitor activity on, and the status of, remote systems from the local system
by using the Sun StorageTek RAID Manager software’s two notification utilities to
broadcast messages—the Notification Manager (see “Setting Up Event Notifications”
on page 99) and the Email Notification Manager (see “Setting Up Email
Notifications” on page 108).

V¥ To View the Full List of Events

1. To open a full-screen version of the event log, click the Events

button.

V¥ To Clear All the Event Logs Belonging to All

HBAs in a System

1. In the Enterprise View, click the system you want.
2. In the menu bar, choose Actions > Clear logs on all controllers.

3. Click Yes to clear the log.

The log for the selected system is cleared, except for one event reporting that the
log was cleared.
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About the Status Icons

The Sun StorageTek RAID Manager software indicates event status with icons. The
following table lists the three categories, or types, of events based on severity.

TABLE7-1  Event Status Icons

Icon Status Examples

Information  The local system successfully connected to a remote system.
A logical drive was created.
A hot-spare was created.
A logical drive was deleted.

Warning A logical drive is in a degraded state.
A logical drive contains one or more bad stripes.
@ A disk drive is being rebuilt.
An HBA is not responding to an enclosure.
An enclosure fan or power supply has failed.

Error An HBA has failed.
A logical drive has failed.
|§| A hot-spare has failed.
A disk drive within a logical drive has failed.
An enclosure is overheating.
Multiple fans or power supplies within an enclosure have failed.
An enclosure is not responding.

Warning- and Error-level icons appear next to components (such as systems and
logical drives) affected by a failure or error, creating a trail, or rapid fault isolation,
that helps you identify the source of a problem when it occurs. See “Identifying a
Failed or Failing Component” on page 160 for more information.

Note — All Warning- and Error-level events also cause the audible alarm to sound.
See “Silencing and Testing the Audible Alarm” on page 120 for more information.
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Using Notifications to Monitor Status

You can set up the Sun StorageTek RAID Manager software to broadcast messages
(or notifications) to selected remote systems and users when an event, such as the
creation of a logical drive or the failure of a disk drive, occurs on the local system.
(For more information about event types, see “Checking Activity in Your Storage
Space” on page 96.)

You can set up one or both of these types of notifications for any system in your
storage space:

m Event notifications—Messages about a system are sent to the Event Viewer of
other systems in your storage space. See the following section.

m Email notifications—Messages about a system are sent by email to specified
users. See “Setting Up Email Notifications” on page 108.

Setting Up Event Notifications

Event notifications are messages about events on one system that are sent to the
Event Viewer of another system in your storage space. These messages, called
logged notifications, can help you monitor activity on your entire storage space from
a single local station, and are especially useful in storage spaces that include
multiple systems running the Sun StorageTek RAID Manager Agent only.

Logged notifications include status information and identify which system (or
source) an event occurred on. For instance, in this example, the Event Viewer
indicates that two logical drives were added to a system named ‘gas1668b’.

FIGURE 7-1 Identifying Event Types

Ciate
{13 04i1 412008
3 0401 452008
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€29 0401 412008
€29 0401 412008
) 0401 452008

Time Saurce Diescription
11:01:44 AM PDT  GAS1668E adaptec.com Added logical device: cantroller 1, logical device 4 ('Logi..
11:01:44 AMPDT  GAS1668B adaptec.com Added logical device: cantroller 1, logical device 3 ('Logi...
110141 AMPDT  GAS16EB8B adaptec.com Successfully applied the new configuration: controller 1.
105348 AM PDT  hou2287c.adaptec.com  Could not clear the event logs for system bou2287c.ada. .
105332 AMPDT  GAS1668B adaptec.com  Could not clear the event logs for system GAS1BEEB ad..
10:40:46 AM PDT  hou2287c.adaptec.com  Reconfiguration complete: contraller 1, logical device 3 (.

Logged notifications are not sent to all systems in your storage space. In the
Notification Manager, you can specify which systems will send and receive logged
notifications; then, you can add or delete systems as your storage space grows and
changes.
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Opening the Notification Manager and Adding
Systems

This section describes how to set up event notifications for one system in your
storage space. You must complete the tasks in this section for each individual system
that you'll be monitoring with logged notifications.

V¥ To Set Up Event Notifications for a System

1.

Note this information for each system that will receive event notifications
about the selected system:

Host name or TCP/IP address
TCP/IP port number (or the default, 34571)

In the Sun StorageTek RAID Manager software menu bar, choose Configure >
system-you-want > Notifications.

FIGURE7-2 Opening the Notification Manager

Properties

E=] Events 'E} Configure @ Help

Physical devices bou2287c.adaptec.cam (Local system) » " General seftings

84 Controller 1 @ @ QNnﬁﬂcatiuns%
=1 Email Mofifications

Channel 0 (14 devices found) Logical devices (3) @Tasks

D b D B B & B & @ A B - |

The Notification Manager is displayed on the Notifications tab of a new window.
The local system is automatically included on the Notification List—by default, all
local events are listed in the local Event Viewer.
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FIGURE 7-3 Notifications Manager
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3. To the Notification List, add the names of the other systems in your storage
space that will receive event notifications generated by the system you selected
in Step 2:

a. In the tool bar, click Add system.

b. In the Add System window, enter the host name or TCP/IP address of the
first system.
If you are not using the default port number, 34571, enter the TCP/IP port.
Then, click Add.

c. If you want more than one system to receive the event notifications, repeat
Step b as required.

d. When done, click Cancel to close the Add System window.

The systems you added are displayed in the Notification List. Although you can’t
sort the list, you can reorganize the columns by clicking and dragging the column
heads.

FIGURE 7-4 Reorganizing the Columns of the Notification List

»f General settings Q Hotifications =1 Email Hotifications {:"j} Tasks 7

Host narr TCRIP address FPaort Last event sent
hnuzza?c.adaptehIZI.EEI.WEI.BS | 344871 |IZI?I1 2005 11:04:56 A .
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You can specify which levels of events are sent to individual systems by following
the instructions in “Modifying the Address, Host Name, or Notification Level of a
System” on page 104.

4. Close the Notifications window when you are done.

Note — You can access other utilities in this window, such as the Task Manager (see
“Managing Tasks” on page 123), by clicking their tabs.

5. Repeat Step 1 to Step 4 for each system you want to monitor with event
notifications.

Sending a Test Event

To ensure that a system is receiving logged notifications, you can send a test event.

V¥ To Send a Test Event

1. Open the Notification Manager.
See “Opening the Notification Manager and Adding Systems” on page 100.

Note — You can also access the Notification Manager by selecting the system you
want in the Enterprise View, then (on the menu bar) clicking Actions > Agent actions
> Configure > Notifications tab.

2. In the Notification List, click on the system you want to send a test event to.

Note — You can only send a test event to one system at a time.

3. On the menu bar, choose Actions > Send test event.

The test event is sent. A message appears indicating either that the test event was
sent successfully or that the test failed. (Click OK to clear the message.)

If the test is successful, the receiving system beeps once, and its Event Viewer shows
that a test event was received.
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FIGURE 7-5 Viewing the Result of a Test Notification
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V¥ To Troubleshoot a Failed Test

1.

Ensure that the receiving system is powered on and running the Sun
StorageTek RAID Manager software.

. Open the receiving system’s System Properties window (see Step 3) and

double-check the TCP/IP address and port number.

. Try sending the test event again.

Managing the Event Notification List

This section describes how to manage systems in the Notification List:

To add a system to the Notification List, see “Setting Up Event Notifications” on
page 99.

To modify a system’s connection information, see “Modifying the Address, Host
Name, or Notification Level of a System” on page 104.

To remove a system from the Notification List, see “Removing a System From the
Notification List” on page 105.

Moditying the Address, Host Name, or Notification
Level of a System

If you want to specify the notification level for a system, or if the TCP/IP
information or host name of a system changes, update its properties in the
Notification Manager.
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Note — Does this system receive event notifications from more than one other
system? Ensure you enter the updated information in the Notification Manager of all
affected systems.

V¥ To Modity System Information

1. Open the Notification Manager.
See “Opening the Notification Manager and Adding Systems” on page 100.

2. In the Notification List, click the system you want to modify.

3. In the System Properties window, enter the new information or select a new
notification level in the Event Type drop-down menu, then click OK.

The Notification List shows the modified information.

FIGURE 7-6 Notification System Properties

£ System properties

Host name |hnu228?c.adaptec.cnm

TCPIP address  [10.20.170.83

TCPIP port 34571
Event type Errar, Warning, Informational
ENune
Efror
Errar, Warning —
Errar, Warning, Informational

Removing a System From the Notification List
You can remove any system (including the local system) from the Notification List.

Once a system has been removed, logged notifications from the local system are no
longer sent to it.
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V¥ To Remove a System From the Notification List
1. Open the Notification Manager.
See “Opening the Notification Manager and Adding Systems” on page 100.
2. In the Notification List, click on the system you want to remove.
3. In the tool bar, click Delete system.

4. Click Yes to confirm the deletion.

The system is removed from the Notification List.

Monitoring and Managing the Notification Log

The Notification Log displays status information and messages about the
Notification Manager itself, such as whether notifications were sent successfully or
not.

This section describes how to manage the Notification Log and use it to monitor the
logged notifications being sent:
m Using the Notification Log (see the following section).

m Clearing the Notification Log (see “To Clear the Notification Log” on page 106).

Using the Notification Log

By default, notification events are listed in the order they occurred, with the most
recent event first. To make it easier to find a specific event, click on the column heads
to sort the events. You can also reorganize the columns by clicking and dragging the
column heads.
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The Notification Log uses icons to show the status of events. These icons also appear
in the Event Viewer of the remote systems.

TABLE7-2  Notification Log Icons

Icon Status Explanation and Solution

Information The Notification Manager successfully connected and sent the event.
No action required.

Error The Notification Manager did not successfully connect to a system or
send an event. Ensure that the correct host name and TCP/IP address
|§| of the receiving system is correct.

Double-click on an event to see basic information about it. Click Next to see the next
event in the list.

FIGURE 7-7 Notification Event Detail Window

r Motification event detail

Type |Infarmatian Source |

Date [5/4/05 Time |3:01:41 AMPDT

Ciescription

Notification Manager started with notifications Enabled.

L_Ereuiuus ]Lﬂext ] Lgl_u_se ] Lﬂelp_]

V¥ To Clear the Notification Log

To make it easier to monitor recent events, you can clear the Notification Log.
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1. Open the Notification Manager.

See “Opening the Notification Manager and Adding Systems” on page 100.

2. In the menu bar, choose File > Clear the event log > Notifications.

FIGURE 7-8 Clearing the Event Log of Notifications
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3. Click Yes to clear the log.

The log is cleared, except for one event reporting that the log was cleared.

Disabling and Re-Enabling Event Notifications

Event notifications are enabled by default. You can choose disable them, if required.

Note — If you disable event notifications, events will be generated but not
broadcast—not even to the local system.

V¥ To Disable Event Notifications

1. Open the Notification Manager.

See “Opening the Notification Manager and Adding Systems” on page 100.

2. In the menu bar, choose Actions > Disable notifications.

Event notifications are disabled. The Notifications tab shows the red ‘disabled’

icon.

Chapter 7 Monitoring Storage Space

107



FIGURE 7-9 Disabling Notifications
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V¥ To Re-Enable Event Notifications

® Follow Step 1 and Step 2 in “Disabling and Re-Enabling
Event Notifications” on page 107, selecting Enable | E Hotifications
Notifications during Step 2.

Setting Up Email Notifications

Email notifications are email messages about events on a system in your storage
space that are sent to specified users. Email notifications can help you monitor
activity on your entire storage space from any location, and are especially useful in
storage spaces that include multiple systems running the Sun StorageTek RAID
Manager Agent only.

Only the users you specify receive email notifications. (See “To Modify Information
About a Recipient” on page 113.) You can specify which types of events generate
email messages to which recipients to ensure that errors receive immediate attention
from the right people.

In the Email Notification Manager, you can add and delete email recipients, and
modify the types of email notices they receive, as your requirements change.

V¥ To Set Up Email Notifications

This section describes how to set up email notifications for one system in your
storage space. You must complete the tasks in this section for each individual system
that you’ll be monitoring with email notifications.

1. Note this information:

108 Sun StorageTek RAID Manager Software User's Guide ¢ May 2009



m The address of your Simple Mail Transfer Protocol (SMTP) server (host name and
domain, or TCP/IP address)

m The name and email address of each person who will receive email notifications

2. In the menu bar, choose Configure > system-name > Email Notifications.

FIGURE 7-10 Opening the Email Notification Manager
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The Email Notification Manager is displayed on the Email Notifications tab of a
new window.

FIGURE 7-11 Displaying the Email Notifications Tab
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3. If this is the first time you are opening the Email Notification Manager,
continue with “To Enter the SMTP Server Settings” on page 110.
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To set up email notifications, continue with “To Add an Email Recipient” on
page 110.

V¥ To Enter the SMTP Server Settings

The first time you are opening the Email Notification Manager, the SMTP Server
Settings window is opened automatically.

1. Enter the address of your SMTP server.

2. Enter the “From” address to be displayed in email notifications.

FIGURE 7-12 SMTP Server Settings Window

£ SMTP server settings

SMTP zerver address |5mptaenrer@adap
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| ok ]| cancel | [ Hep |

If email recipients will be replying to email notifications, be sure that the “From”
address belongs to a system that is actively monitored.

3. Click OK to save the settings.

4. To set up email notifications, continue with “To Add an Email Recipient” on
page 110.

V¥ To Add an Email Recipient

1. Open the Email Notification Manager.
See “Setting Up Email Notifications” on page 108.

2. In the menu bar, click Add email recipient.

The Add Email Recipient window is displayed.

3. In the Add Email Recipient window, enter the name and email address of the
recipient.

4. In the Event Type drop-down menu, select an event level.
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FIGURE 7-13 Add Email Recipient Window
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For more information on event levels, see “About the Status Icons” on page 98.

5. Click Add.

6. Repeat Step 3 to Step 5 to add more email recipients.

7. Click Cancel to close the Add Email Recipient window.

The email recipients you added are now displayed in the Email List.

FIGURE 7-14 Email Recipients in the Email List

File Wiew Actions Help
E, Add email recipient @

4

@ Help

vf General settings Q Wotifications [=1 Email Notifications {B Tasks ]
Recipient name Email address Event type Lastmessage sent
Bob Fraser Boh Fraser@adaptec.com [Error, Warning Mever
Lisa Boojoy Lisa Boojoviadantec.c. . |Errar Warning, Infarmatio.. Mever
FPauline Brant FPauline_Brant@adaptec... [Errar Mever

Although you cannot sort the list, you can reorganize the columns by clicking and
dragging the column heads.

8. Close the Email Notifications window when you are done.

Note — You can access other utilities in this window, such as the Task Manager (see
“Managing Tasks” on page 123), by clicking their tabs.
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9. Repeat Step 1 to Step 8 for each system you want to monitor with email
notifications.

V¥ To Send a Test Message

To ensure that an email recipient is receiving event notifications, you can send them
a test message.

1. Open the Email Notification Manager.
See “Setting Up Email Notifications” on page 108.

Note — You can also access the Notification Manager from the menu bar by choosing
Actions > Agent actions > Configure > Email Notifications tab.

2. Click the email address to which you want to send the test message.

Note — You can only send a test message to one email address at a time.

3. On the menu bar, choose Actions > Send test message.

FIGURE 7-15 Sending a Test Email Message

File  View “Actions  Help

# Add

»f Genera

Recipi
Bob Fraser
Lisa Boojoy
Fauline Brar

il Add email recipient Lcipiem & Modify email recipient @ Help
& Delete email recipient Fmail Natifications | (D) Tasks |
& Modity email recipient Ewent type Last message sent
Send test message I |Err|:|r, Wiarning | MHever
SMTF server settings % aclg:z: Warning, Infu:urmatiu:u...l EE:E:

Disahle Email Motifications

The test message is sent.
If the test is successful, the email recipient receives the test message. If the test
fails:

a. Ensure that the recipient’s email address is correct. (See “To Modify
Information About a Recipient” on page 113 to modify the address.)
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b. Ensure that your SMTP server address is correct. (See “To Change the Email
Notification Manager Settings” on page 116 to modify the address.)

c. Try sending the test message again.

Managing the Email List

This section describes how to:
m Add an email recipient, see “To Add an Email Recipient” on page 110.

m Modify an email recipient’s information, see “To Modify Information About a
Recipient” on page 113.

m Remove an email recipient, see “To Remove a Recipient From the Email List” on
page 113.

V¥ To Modity Information About a Recipient

If the email address of a recipient changes, or if you need to change the types of
event notifications the recipient receives, you can update the information about the
recipient in the Email List.

1. Open the Email Notification Manager.
See “Setting Up Email Notifications” on page 108.

2. Click on the name of the recipient.

3. Modify the information about the recipient as required, then click OK.

V¥ To Remove a Recipient From the Email List

You can remove any recipient from the Email List. Once a recipient has been
removed, event notifications from the local system are no longer sent to that email
address.

1. Open the Email Notification Manager.
See “Setting Up Email Notifications” on page 108.

2. Click the recipient you want to remove.
3. In the menu bar, choose Delete email recipient.

4. Click Yes to confirm the deletion.

The recipient is removed from the Email List.
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Monitoring and Managing the Email Log

The Email Log displays status information and messages about the Email
Notification Manager itself, such as whether email notifications were sent
successfully or not.

By default, email events are listed in the order they occurred, with the most recent
event first. To make it easier to find a specific event, click on the column heads to
sort events. You can also reorganize the column by clicking and dragging the column
heads.

This section explains how to use and clear the Email Log.

V¥ To Use the Email Log

1. Double-click on an event to see basic information about the event, including
the event type.

See “About the Status Icons” on page 98 for a list of event types.

FIGURE 7-16 Email Event Detail Window

-
?’ Email event detail

Type |Inf|:|rmati|:|n Source |Emai| Motification Manager

Diate [5i5i05 Time [7:55:22 AMPOT

Ciescription

Email Notification Manager started with messages Enabled.

L_Ereuiuus ]Lﬂext ] Lglu_se ] Lﬂglp ]

2. Click Next to see the next event in the list.
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V¥ To Clear the Email Log

1. Open the Email Notification Manager.
See “Setting Up Email Notifications” on page 108.

2. In the menu bar, choose Clear the event log > Email Notifications.

FIGURE 7-17 Clearing the Event Log of Email Notifications

File View Actions Help

Clearthe event log » = notifications
Close help =1 Email Nntiﬂcatinns%
Close (D Tasks

3. Click Yes to clear the log.

The log is cleared, except for one event reporting that the log was cleared.

V¥ To Change the Email Notification Manager
Settings

You can modify these Email Notification Manager settings as your needs change:

m Address of your SMTP server

m ‘From’ address that will appear in email notifications

1. Open the Email Notification Manager.
See “Setting Up Email Notifications” on page 108.

2. In the menu bar, choose Actions, > SMTP server settings.

The SMTP server settings window is displayed.
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FIGURE 7-18 Changing the SMTP Server Settings for the Email Notification Manager

File View [Actions Help
@ aad @ Add email recipient & 4@ Help
@ Delste email recipient Fmail Notifications | (D) Tasks |

& Modity email recipient Event type Last message sent
Send test message m |Errar, \Warning 02005 11:42:05 .

B... |Errar, Warning, Informatio... 0718520058 11:44:08 ..

c...|Errar Warning, Informatio... OFMi200511:42:12 ..

Recipi

Pauling Brat

SMTF server settings [%

Disable Email Motifications

3. Enter the address of the SMTP server.

4. Enter the From address that will be displayed in email notifications.

If email recipients will be replying to email notifications, be sure that the From
address belongs to a system that is actively monitored.

5. Click OK to save the settings.

V¥ To Disable Email Notifications

Email notifications are enabled by default, but can be disabled if required.

Note — If you disable email notifications, events will be generated but email notices
won't be broadcast.

1. Open the Email Notification Manager.
See “Setting Up Email Notifications” on page 108.

2. In the menu bar, choose Actions > Disable Email Notifications.
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FIGURE 7-19 Disabling Email Notifications

File View [Actions Help
& Add

Recipi

Pauling Brat

ﬂ. Add ernail recipient f& @ Help

@ Delete email recipient Fmail Notifications | (D) Tasks |

& Modify email recipient Event type Last message sent
Send test message 1 [Errar, YWarning 0752005 11:42:05 ..

B... |Errar, Warning, Informatio... 0718520058 11:44:08 ..
c...|Errar Warning, Informatio... OFMi200511:42:12 ..

SMTF server settings

Disable Email Motifications %_ '

Email notifications are disabled. The Email Notifications
tab shows the red disabled icon. | E Notifications

V¥ To Re-Enable Email Notifications

® Follow Step 1 and Step 2 in “To Disable Email Notifications” on page 116,
selecting Enable Notifications during Step 2.

Broadcasting Event Alerts to Users

You can set the Sun StorageTek RAID Manager Agent to send event alerts about a
specific system to all users who are logged into your storage space. You might want
to do this if your storage space isn’t managed by a dedicated person, or if that
particular system is off-site or not connected to a monitor. Event alerts signal
everyone working on the storage space that a system requires technical assistance.

When you set the Sun StorageTek RAID Manager to broadcast event alerts, all
logged-in users receive messages about all types of events. In Windows, these alerts
appear as pop-up messages; in all other operating systems, these alerts appear as
console messages.

When enabled, event alerts occur independent of event notifications (see “Setting Up
Event Notifications” on page 99) and email notifications (see “Setting Up Email
Notifications” on page 108).
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V¥ To Enable Event Alerts

1. On the menu bart, choose Configure > system-name > General Settings.

FIGURE 7-20 Enabling Event Alarms

| X configure. | & Help
. hou22eTeadaptec.com (Local systern) # P e %
i @ = notifications B

=1 Email Motifications
Logical devices (3 {9 e

EEE - 0o

The General settings window is displayed for that system.
2. Select Broadcast events to logged-in users, then click Save changes.

3. Restart the Sun StorageTek RAID Manager software to apply the change.

Managing Enclosure Status

If your storage space includes an enclosure with an enclosure management device,
such as a SCSI Accessed Fault-Tolerant Enclosure (SAF-TE) processor, the Sun
StorageTek RAID Manager software displays temperature, fan, and power module
status in the Physical Device view, as shown in the following figure.

FIGURE 7-21 Enclosure Status Icons

Physical devices |
% Controller 1 &

Enclosure O (ADAPTEC SANBIOr 5500

h O & é P
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The enclosure status icons change color to indicate status.

TABLE 7-3  Enclosure Status Icons

Icon Status Examples
Enclosure Fans Normal Fans are working properly.
Warning A fan has failed.
(]
Error Multiple fans have failed.
HBA Battery Normal Battery temperature and charge is normal.
i
Enclosure Normal Enclosure temperature is normal.
Temperature
Warning Enclosure temperature is higher than normal.
Error Enclosure is overheating.
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TABLE 7-3  Enclosure Status Icons

Icon Status Examples

Enclosure Power Normal Power supplies are working normally.

Warning One power supply has failed.

Error Multiple power supplies have failed.

Note — If your enclosure does not have an enclosure management device, the status
icons appear but do not indicate status.

Silencing and Testing the Audible Alarm

The Sun StorageTek RAID Manager software supports an audible alarm which is
triggered on the local system when a Warning- or Error-level event (see “To View
Event Details” on page 96) occurs on any system in the Enterprise View. The alarm is
a series of beeps, which sound every five minutes until the event is resolved.

The alarm is disabled by default, but can be enabled on any system. You can also
change the frequency and duration of the alarm (see “To Change Alarm Settings On
a System” on page 63 for more information).

This section describes how to:

m Enable a system’s alarm (see “To Enable an Alarm for a System” on page 121).

m Ensure the alarm is working on your local system (see “To Test the Alarm” on
page 122).

m Silence a sounding alarm (see “To Silence the Alarm” on page 122).
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V¥ To Enable an Alarm for a System

1. In the Enterprise View, select the system you want.

2. In the menu bar, choose Actions > Agent actions > Alarm Actions > Enable.

FIGURE 7-22 Enabling Alarms

File Wiew Rernote Actions Help

M aga B

Enterprise view

=1 & Internal RAID
= [ bouz287a.a
= Controlh
= Controlh
= Controlh
= ¥ GAS16688.:
= Controlh
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{33 Hirts and tips | -l Events ), Configure_ 48 Help
Log out |22B?a.adantec.cum Local system)
Agent actions 3 Configure
Save printable canfiguration View evant log ‘
Save support archive Alarm actions  » Ena |E
Clear logs on all controllers  [ontroller 1 2
: D contraller RAID cantraller
Change display group 3
Fropeties

The alarm is enabled for that system.

V¥ To Disable an Alarm

® Repeat Step 1 and Step 2, above, but choosing Disable instead.

Caution — When the alarm is disabled, no audible signal sounds when a Warning-
or Error-level event occurs on the system.

V¥ To Test the Alarm

1. Ensure that the speakers on your local system are not muted.

2. In the Enterprise View, click on your local system.

3. In the menu bar, choose Actions > Agent actions. > Alarm actions > Test alarm
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FIGURE 7-23 Testing the Alarm
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The alarm sounds.

4. To stop the test, click OK.

V¥ To Silence the Alarm

When a Warning- or Error-level event occurs, you can silence the alarm on your local
system while you fix the problem.

® Click the Silence button in the main the Sun StorageTek RAID
Manager window. Q. Silence

Or:

® In the menu bar, choose Actions > Agent actions > Alarm actions > Silence
alarm.
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CHAPTER 8

Managing Tasks

The Sun StorageTek RAID Manager software allows you to schedule some types of
jobs (or tasks) to complete at convenient times. Additionally, you can schedule some
tasks to recur at preset times.

A Task Manager utility helps you manage the tasks you schedule.

This chapter describes how to schedule, monitor, and manage tasks. The chapter
contains the following sections:

m “Scheduling a Task” on page 123

m “Opening the Task Manager” on page 126

m “Monitoring Tasks” on page 127

m “Modifying a Task” on page 129

m “Deleting a Task” on page 131

m “Disabling the Task Manager” on page 131

Scheduling a Task

If a task is lengthy and limits access to components on your storage space, you may
want to set a date and time for the task to complete, instead of running the task
while there is activity on your storage space.

If a task must be performed regularly, you can schedule it to recur at preset times.

You can schedule these Sun StorageTek RAID Manager software tasks:
m Expanding a logical drive
m Changing a logical drive’s RAID level

m Modifying the stripe size of a logical drive
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m Verifying a logical drive

m Verifying and fixing a logical drive

V¥ To Schedule a Task

1. Complete each step of the task until you are prompted to click Apply.

Do not click Apply. You will see a Schedule button on the Configuration
Summary screen.

FIGURE 8-1 Accessing the Schedule Button

Below is the configuration chande initiated by the logical-drive reconfiguration function. To save this
configuration, click Apply.' To schedule the reconfiguration for a later time and date, click 'Schedule.’
To cancel the changes, click 'Tancel!

Configuration summary \|

Click ABpply' to save your canfiguration chanoes.

RAID level Meve BAID [evel Size Mew size
(&) RaDO (&) RaDO 19,367 GE 79.051 GE

L = Back ]L Apphy ]L Schedule = ] L Cancel ] L Help ]

2. Click Schedule.
The schedule window is displayed.
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FIGURE 8-2 Schedule Window

Choose the time and date you wish to start the reconfiguration. To schedule the
recanfiguration click ‘Apply' To cancel the changes, click 'Cancel.!

03:54 PM PDT, 17 Jul EEIEIEil
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1
2 3 4 &5 6B 7 8
9 10 11 12 13 14 15
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23 24 25 2B 27T I8 129
a3

L = Back ]L Apphy ] L Cancel ] L Help ]

3. Set the date and time for the task.

Note — Keep geography in mind—If you are scheduling tasks on remote systems
located in other geographical areas, remember that the time you set for a scheduled
task is that system’s time, which may be different from local time. You will be
prompted to select a new time if the one you've set occurs in the past on the remote
system.

4. Set the recurrence frequency, if the option is available for this task and you
want it to occur regularly.

5. Click Apply.

The task is saved in the Task Manager, and the scheduled task is added to the
Task List.
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Opening the Task Manager

You can use the Task Manager to monitor and modify the tasks you have scheduled.
To schedule a task, see “Scheduling a Task” on page 123.

Tasks are associated with systems. When you open the Task Manager, you see the
scheduled tasks associated with that local or remote system only.

To Open the Task Manager

1. From the menu bar, choose Configure > system-name> Tasks.

FIGURE 8-3 Opening the Task Manager
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o evns vy
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[

The Task Manager is displayed on the Tasks tab of a new window. The Tasks tab
has two main panels: the Task List (upper panel) and the Task Event Log (lower
panel).
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FIGURE 8-4 Task Manager Window

File View Actions Help
9 Deletetask  [5H Modifytask

I8 view task

»f General settings \‘ ,@Nmrﬁcaﬁuns \‘ [=1 Email Motifications \| {:‘;} Tasks \|
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2 | SatD4MA/2006 02:00:50 P POT | Mever |Expand or change.|
Date Time Source Task event description

@ 0411 4/2006  10:19:22 AM PDT

Task Manager started with tasks Enahled.

Note — From the Tasks tab, you can access other utilities in this window, such as the
Email Notification Manager (see “Setting Up Email Notifications” on page 108), by

clicking their tabs.

Monitoring Tasks

Use the two main panels of the Task Manager—the Task List and the Task Event
Log—to monitor tasks.

Monitoring Upcoming Tasks in the Task List

The Task List displays all scheduled tasks in order of creation, and includes basic
information about each task. Although you can’t sort the tasks in any other order,
you can reorganize the columns in the Task List by clicking and dragging the

column heads.

The Status column of the Task List shows the current condition of each task:

m Scheduled—The task is scheduled to be completed at a future date and time.

m Executed—The task has been completed successfully.

m Executed*—A recurring task has been completed once and will be repeated at the

scheduled time.
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m Error—The task has not been completed successfully. (For more information
about an error, double-click the task in the Task List to open the Task Properties
window.)

In the menu bar, click View task for additional detail about any task in the Task List.

V¥ To Check Past Tasks and Events in the Event
Log

The Event Log displays detailed information about the Task Manager itself, such as
when scheduled events were modified, deleted, or completed successfully.

By default, task events are listed in the order they occurred, with the most recent
event first.

1. Click on the column heads to sort task events.

You can also reorganize the columns by clicking and dragging the column heads.

2. Review the icons to determine the status of past tasks.

The following table describes the Event Log uses icons.

TABLE 8-1 Event Log Icons

Icon Status Explanation and Solution

Information  The task or event completed successfully. No action required.

Warning The task missed its start time. Reschedule the task to clear the error,
as described in “Modifying a Task” on page 129.

A

Error The task failed. Delete the task to clear the error. Schedule the task
again, as described in “Scheduling a Task” on page 123.)

®

3. Double-click on an event to see basic information about the event.

4. Click Next to see the next event in the list.
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Moditying a Task

If your requirements change, you can reschedule a task to a different date or time.
You can also modify the task description that appears in the Task List. Creating a
custom task description makes it easier to find the task in the Task List.

V¥ To Modify a Scheduled Task

1. From the menu bar, choose Configure > system-name > Tasks (as shown in

FIGURE 8-3).

The Task Manager is displayed.

2. In the Task Manager, select the task you want to change, then click Modify

task.

FIGURE 8-5 Modifying a Scheduled Task

File Wiew Actions Help

% Delete task Modify task [{ [ Viewtask & Help
»’ General settings \i Qﬂmmcaﬁuns =] Email Notifications \‘ @ Tasks ]
D Scheduled Start Time Status Recurring Description
2 | Tue 0503520056 01:30:47 P PDT | Executed [ ever Expand ar change logical device
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4 | Tue 05703520048 04:22:41 PWM PDT | Executed [+ ever Expand or change logical device
L} | Fri O7M&/2005 01:30:56 PM POT | Scheduled ever Expand ar change logical device
Date Time Source Task event description

@D?H ar20045 01:13:36 PM PDOT  Task Manager Tazk a scheduled.

@DTH ar20045 11:44:41 AM PDT  Task Manager Task scheduling is enahled.

@D?H ar2005 11:44:389 AM POT  Task Manager Task scheduling is disahled.

@D?H ar20045 11:44:31 AMPDT  Task Manager Task scheduling is enahled.

@DTH af20045 03:38:04 AW PDT Task Manager started with tasks Disahble...

3. In the Modify Task window, make the required changes, then click OK.
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FIGURE 8-6 Modify Task Window
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The task and Task List are updated with the new information.

Rescheduling a Task Following a Missed Start
Time

Tasks scheduled in the Sun StorageTek RAID Manager software include an
automatic 30-minute grace period following their start time, to accommodate
temporary interruptions. For instance, if there’s a brief power outage a task will run
once normal conditions resume, if the interruption lasts no longer than 30 minutes
past the scheduled start time.

If a task misses its start time, it must be rescheduled. For instructions, see
“Modifying a Task” on page 129.

If a recurring task misses its start time, it is automatically rescheduled to run at the
next scheduled interval.
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Deleting a Task

If a scheduled task is no longer required, you can delete it from the Task Manager.

V¥ To Delete a Task

1. From the menu bar, choose Configure > system-associated-with-the-task-you-want-
to-delete > Tasks (as shown in FIGURE 8-3).

The Task Manager is displayed.

2. In the Task Manager, select the task you want to delete, and click Delete task.

FIGURE 8-7 Deleting a Task

File  Miew Actions Help

Modifytask [ Viewtask 48 Help
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4 | Tue 090372005 04:22:41 PM PDT | Executed [Hewer Expand ar change logical device
a | Mon 071 852005 01:30:56 FM PDT | Scheduled Hever Expand or change logical device

3. Click Yes to confirm the deletion.
The task is deleted.

Disabling the Task Manager

The Task Manager is enabled by default. If you do not wish to schedule tasks on a
selected system, you can disable it.

Note — If you disable the Task Manager, no scheduled tasks will run on that system.
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V¥ To Disable the Task Manager

1. From the menu bar, choose Configure > system-name > Tasks (as shown in
FIGURE 8-3).

The Task Manager is displayed.

2. In the Task Manager menu bar, choose Actions > Disable Task Scheduler.

FIGURE 8-8 Disabling the Task Manager

File wiew ' Acfions  Help

@ ﬁ' Delete task : @ Help
o Genera [ Modifytask =] Email Motifications \‘ ¢L) Tasks 1
[ View task Status Recurting Diescription
Tu D[sableTaskﬁcheduler ecuted Mever Expand or change logical device
3 | Tueemoo oo ro—daom T recuted [Hewvar Expand or change logical device
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The Task Manager is disabled. The Tasks tab shows the red disabled )
icon. [Bree ]

Note — When the Task Manager is disabled, a brief three-tone alert sounds each time
you open and log into the Sun StorageTek RAID Manager software. Scheduled tasks
in the Task List will not run while the Task Manager is disabled.

V¥ To Re-Enable the Task Manager

Follow the steps in “Disabling the Task Manager” on page 131, selecting Enable Task
Scheduler during Step 2.

Scheduled tasks that have missed their start times must be rescheduled if you want
them to run. See “Modifying a Task” on page 129 for instructions.

Scheduled tasks that did not miss their start time while the Task Manager was
disabled will run as scheduled.
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CHAPTER 9

Working with Display Groups

This chapter describes how to work with and manage display groups in the Sun
StorageTek RAID Manager software.

To create display groups, see “Creating Display Groups” on page 56.

The chapter contains the following sections:

m “Adding a System to a Display Group” on page 133

m “Viewing Display Group Status” on page 134

m “Moving a System From One Display Group to Another” on page 135
m “Renaming a Display Group” on page 136

m “Removing a System From a Display Group” on page 137

m “Deleting a Display Group” on page 137

Adding a System to a Display Group

As your storage space grows and changes, you can add new systems to your display
groups.

V¥ To Add a System to a Display Group

1. Right-click on the system in the Enterprise View.

A navigational menu is displayed.

2. From the navigational menu, choose Change display group > display-group-name.
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FIGURE 9-1 Changing a Display Group
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The system is added to the display group.

FIGURE9-2 System Added to a Display Group
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Note — A system can belong to only one display group at a time; you can’t include
the same system in multiple display groups.

Viewing Display Group Status

To quickly view the status of systems within a display group, you can open the
display group Properties window.
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V¥ To View the Display Group Properties

® In the Enterprise View, right-click on the display group, and choose Properties.

The Properties window is displayed for that display group, summarizing the
status of the systems that belong to that group.

Moving a System From One Display
Group to Another

V¥ To Move a System From One Display Group to
Another

1. In the Enterprise View, right-click the system you want to move.

2. Choose Change display group > new-display-group-name.

FIGURE 9-3 Moving a System to a New Display Group

Enterprise view @ bou2287a.adaptec.com (Local £
= (3 Internal RAID
= [EF Group A | taeln
= [ bou2287a.adap ; ;
84 Controller 1 @ Hints and tips 1 .
¥ Controller 2 Log out gller RNDE
¥ Controller 3 Agent actions k
= EF Group B i .
= @ GAS1668B.ada) Save printable configuration
¥ Controller 1 Save support archive
¥ Controller 2 Clear logs on all controllers
(3 External RAID
Change display group * Mone
Properties & Group &
Group B
(R I=AT grn%...

The system moves to its new display group.
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Renaming a Display Group

You can make managing your storage space easier and more efficient by giving your
display groups meaningful names.

V¥ To Rename a Display Group

1. In the Enterprise View, right-click on the display group.

A navigational menu is displayed.

2. From the navigational menu, choose Rename display group.

FIGURE 9-4 Renaming a Display Group
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3. Enter a new name for the display group, then click OK.

The Enterprise View shows the new name of the display group.
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Removing a System From a Display
Group

V¥ To Remove a System From a Display Group
1. In the Enterprise View, right-click the system you want to remove.
A navigational menu is displayed.

2. From the navigational menu, choose Change display group > None.

The system is removed from the display group.

Note — Systems that are not part of display groups are listed at the top of the
Enterprise View, above any display groups.

Deleting a Display Group

If required, you can delete a display group. When you delete the display group, the
systems that belonged to it are listed at the top of the Enterprise View, above any
remaining display groups.

V¥ To Delete a Display Group
1. In the Enterprise View, right-click on the display group.
A navigational menu is displayed.

2. From the navigational menu, choose Delete display group (as shown in
FIGURE 9-4).

The display group is deleted and the systems that belonged to it are no longer
grouped together in the Enterprise View.
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CHAPTER 10

Managing HBAs, Disk Drives, and
Enclosures

This chapter describes how to manage the HBAs, disk drives, and enclosures in your
storage space. The chapter contains the following sections:

m “Viewing Component Properties” on page 139

m “Blinking a Component” on page 140

m “Managing Disk Drives” on page 141

m “Managing HBAs” on page 144

m “Managing Enclosures” on page 148

m “Updating HBA BIOS and Firmware” on page 150

Viewing Component Properties

Click on any component in the main window of the Sun

StorageTek RAID Manager software, then click the Properties Properties
button (shown at right) to view version numbers, status, model

numbers, and other information about that component.

The properties listed vary, depending on which type of component you select.
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Blinking a Component

You can blink the LEDs on enclosures, or disk drives inside enclosures, to identify
where they are physically located in your storage space. This table describes how to
blink specific enclosures and disk drives.

TABLE 10-1 Icons That Cause LEDs to Blink

To Blink This LED Right-Click On This Icon
The disk drive Disk Drive icon
=y
All disk drives connected to that HBA icon (in the Enterprise View or in the
HBA Physical Devices View)
The enclosure Enclosure Management Device icon
All disk drives included in a Logical Drive icon
logical drive
All disk drives included in all the Text—In the Logical
logical drives on a selected HBA |[% Logical devices Devices View of a HBA
with multiple logical
drives
All disk drives connected to Text—In the Physical Devices View of a
selected HBA ports HBA with multiple ports
All disk drives connected to a Text—In the Physical Devices View
selected HBA channel of a HBA with multiple channels
annel
All disk drives connected to a Text—In the Physical Devices View

selected HBA connector of a HBA with multiple connectors

V¥ To Blink a Component

1. In the Sun StorageTek RAID Manager software, right-click the component,
then click Blink....
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Note — If the component you select (for instance, a HBA) doesn’t support the blink
function, the Blink... option won’t appear in the menu.

The LEDs on the disk drives or enclosures begin to flash.

2. Click OK to stop blinking the component.

Managing Disk Drives

This section describes how to use the Sun StorageTek RAID Manager software to
manage the disk drives that are part of your storage space.

Replacing Disk Drives in a Logical Drive

You can replace one or more disk drives in a logical drive. You may want to do this
to upgrade to larger disk drives, or to make disk drive size uniform across the
logical drive.

Caution — If another disk drive in the logical drive fails during rebuild (see
“Rebuilding Logical Drives” on page 167), you may lose data.

V¥ To Replace a Disk Drive in a Logical Drive
1. In the Physical Devices View, click the disk drive you want to replace.

2. Set the drive state to failed.
See “Setting a Disk Drive to ‘Failed”” on page 142.

3. Remove and replace the disk drive with one of equal or larger size.

4. Wait for the logical drive to rebuild.
See “Rebuilding Logical Drives” on page 167.

5. Repeat Step 1 to Step 4 for all the disk drives you want to replace.

For help solving disk drive problems, see “Recovering From a Disk Drive Failure”
on page 161.
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Setting a Disk Drive to ‘Failed’

Before you can remove a disk drive, you must set it to a failed state to protect your
data.

Caution — You may lose data or damage your disk drive if you remove a disk drive
without first setting it to a failed state.

You can set a disk drive to a failed state if:
m The disk drive is not part of a logical drive, or

m The disk drive is part of a redundant, healthy logical drive

You can’t set a disk drive to a failed state if doing so will take a logical drive offline.

V¥ To Set a Disk Drive to a Failed State

1. In the Physical Devices View, click the disk drive.

2. From the menu bar, choose Actions > Set drive state to failed.
3. Click Yes to set the drive status to failed.

4. Remove and replace the disk drive.

5. If the logical drive that the disk drive belongs to is failed, see “Recovering
From a Disk Drive Failure” on page 161.

Initializing Disk Drives

You can use the Sun StorageTek RAID Manager software to initialize any disk drives
that are in a Ready state, if required. You may want to do this to erase all existing
data and metadata (including all logical drive information).

Caution — Do not initialize a disk drive that is part of a logical drive. Initializing a
disk drive that’s part of a logical drive may make the logical drive unusable.
Back up all data from your disk drive before you initialize it.

V¥ To Initialize a Single Disk Drive

1. In the Physical Devices view, click the disk drive you want to initialize.
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2. In the menu bar, choose Actions > Initialize.

FIGURE 10-1 Initializing a Disk Drive
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3. Click Yes to initialize the disk drive.

The initialization begins.

V¥ To Initialize All Ready Disk Drives on a HBA

1. In the Enterprise View, click the HBA whose disk drives you want to initialize.

2. In the menu bar, choose Actions > Initialize all ready drives.
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FIGURE 10-2 Initializing All Ready Disk Drives
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3. Click Yes to initialize the disk drives.

The initialization begins.

Managing HBAs

This section describes how to use the Sun StorageTek RAID Manager software to
manage the HBAs that are part of your storage space. It contains the following
subsections:

m “To Register a New HBA” on page 144.

m “To Test an HBA Alarm” on page 145.

m “To Silence an HBA Alarm” on page 145.

m “To Disable an HBA Alarm” on page 146.

m “To Rescan an HBA” on page 146.

m “To Save The HBA Configuration” on page 147.

V¥ To Register a New HBA

When you log into the Sun StorageTek RAID Manager software, it searches for new
HBAs in your storage space. If it detects a new HBA, you are prompted to register it.
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® Click Register Now on the New hardware detected window.

Follow the on-screen instructions to complete the registration.

V¥ To Test an HBA Alarm

Note — Not all HBAs have alarms. Refer to your HBA documentation for more
information.

1. Ensure that the speakers on your local system aren’t muted.
2. In the Enterprise View, select the HBA you want.

3. In the menu bar, choose Actions > Alarm actions > Test alarm.

FIGURE 10-3 Testing the Alarm
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The alarm sounds.

4. To stop the test, click OK.

V¥ To Silence an HBA Alarm

You can silence the alarm on a HBA while you fix the problem.

® Click the Silence button in the main Sun StorageTek RAID
Manager software window. i Silence
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V¥ To Disable an HBA Alarm

You can disable the alarm for a selected HBA.

occurs on the HBA.

iii Caution — If you disable the alarm, no audible signal will sound when an error

1. In the Enterprise View, select the HBA you want.
2. In the menu bar, choose Actions > Alarm Actions > Disable.

The alarm is disabled for that system.

V¥ To Rescan an HBA

After you connect a disk drive to or remove a ‘Ready’ (non-failed) disk drive from
an HBA, the Sun StorageTek RAID Manager software may not recognize the change
until it rescans the HBA.

1. In the Enterprise View, click the HBA.

2. From the menu bar, choose Actions > Rescan.
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FIGURE 10-4 Rescanning the HBA
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The Sun StorageTek RAID Manager software scans all the channels or ports on
the HBA you selected.

When the scan is complete, a report is displayed.

3. Click Done after you have reviewed the scan report.

To Save The HBA Configuration

If you require a record of your HBA configurations, you can use the Sun StorageTek
RAID Manager software to create a text file with this information about all HBAs on
a selected system:

m HBAs
m Disk drives
m Disk drives used in logical drives

m Logical drives
1. In the Enterprise View, click the local or remote system.

2. From the menu bar, choose Actions > Save printable configuration.
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FIGURE 10-5 Saving the HBA Configuration
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The Save window is displayed.
3. In the Save window, browse to the directory you want, then enter a file name
for the report.

The default directory is the directory in which the Sun StorageTek RAID Manager
software is installed. The default file name is RaidCfg. log.

A text-file report is saved.

Managing Enclosures

This section describes how to manage the enclosures in your storage space. The
section contains the following subsections:

m “To Test an Enclosure Alarm” on page 148
m “To Silence an Enclosure Alarm” on page 149.

m “To Disable an Enclosure Alarm” on page 149.

V¥ To Test an Enclosure Alarm

1. Ensure that the speakers on your local system are not muted.

2. In the Enterprise View, select the HBA that is connected to the enclosure you
want.
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3. In the Physical Devices View, right-click the enclosure icon of the enclosure
that you want.

A navigational menu is displayed.

4. Choose Alarm actions > Test alarm.

FIGURE 10-6 Testing the Enclosure Alarm
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The alarm sounds.

5. To stop the test, click OK.

V¥ To Silence an Enclosure Alarm

You can silence the alarm on an enclosure while you fix the problem.

® Click the Silence button in the main Sun StorageTek RAID
Manager software window. I;%. Silence

V¥ To Disable an Enclosure Alarm

You can disable the alarm for a selected enclosure, if required.

Caution — If you disable the alarm, no audible signal will sound when an error
occurs on the enclosure.
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1. In the Enterprise View, select the HBA that is connected to the enclosure you
want.

2. In the Physical Devices View, right-click the enclosure icon of the enclosure
that you want.

A navigational menu is displayed.

3. Choose Alarm actions > Disable.

FIGURE 10-7 Disabling the Enclosure Alarm
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The alarm is disabled for that system.

Updating HBA BIOS and Firmware

Note — Do not perform this task if you are not and advanced user.

The Sun StorageTek RAID Manager software provides a wizard to help you update
the BIOS and firmware for the HBAs in your storage space. The ROM Update
wizard updates the BIOS and firmware for all HBAs of the same type on local and
remote systems. You can update one type of HBA at a time.
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Before You Begin
Before you begin, download the latest firmware images from

http://support.intel.com/support/go/sunraid.htm Image files typically
come in sets of two or more and have a .ufi file extension.

V¥ To Update the HBA BIOS and Firmware

1. In the Enterprise View, right-click Direct attached storage.

A navigational menu is displayed.

2. Choose Update controller images.

FIGURE 10-8 Updating the HBA BIOS and Firmware
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The ROM Update wizard opens.
3. Click Next.

4. Click Add to browse to the firmware image files you downloaded, select the
files, then click Open.

Chapter 10 Managing HBAs, Disk Drives, and Enclosures 151


http://support.intel.com/support/go/sunraid.htm

FIGURE 10-9 Opening the Firmware Image Files
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5. In the wizard, select the image files you want, then click Next.

FIGURE 10-10 Selecting the Image Files in the Wizard
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6. Select the HBAs you want to update, then click Next.

FIGURE 10-11 Choosing the HBAs You Want to Update
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7. Review the update summary, then click Apply.
8. When prompted, click Yes to begin the update.
iii Caution — Do not power down the HBA(s) during the update.

9. When the update is complete, click OK.

10. Restart the server(s) to activate the new firmware images.
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CHAPTER 1 1

Configuring SNMP Support

This chapter describes how to configure SNMP support for the Sun StorageTek
RAID Manager software. The Sun StorageTek RAID Manager software supports
SNMP “gets” and “traps” through the use of an SNMP agent. The chapter contains
the following sections:

m “Configuring SNMP Support on Windows” on page 155
m “Configuring SNMP Support on Linux” on page 157

Configuring SNMP Support on
Windows

Note — Be sure your Windows installation includes SNMP support. By default,
Windows 2000 and Windows XP do not install SNMP.

V¥ To Install and Configure SNMP Support

1. Run the Sun StorageTek RAID Manager software installation program, as
described in “Installing the Software” on page 9.

SNMP support is installed automatically, unless you choose to not install it.

2. Follow the on-screen instructions to complete the installation, then restart your
system.

3. Open the Windows Computer Management tool, and select Services from the
tree.
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FIGURE 11-1 Selecting Services From the Windows Computer Management Tool
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4. Double-click SNMP Service.
The SNMP Service Properties window is displayed.

5. Click the Traps tab, then enter the IP address of each system on which you
want to enable traps.

6. Click OK.

7. Start the SNMP service.
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Configuring SNMP Support on Linux

For the Linux operating system, the Sun StorageTek RAID Manager software SNMP
agent is a sub-agent that interfaces with the UCD-SNMP agentx architecture. UCD-
SNMP is a third-party package for Linux; for information, documentation, and
downloads, see www.net-snmp.org.

To Configure SNMP Support

1.

Install the Sun StorageTek RAID Manager software as described in “Installing
the Software” on page 9.

. Add Sun OID information and agentx extension information to the snmp.conf.
. Delete /var/agentx/master (socket file for agentx).
. Start the snmpd daemon and agentx.

. Start aus-snmp daemon.

Refer to your Linux documentation for information on configuring UCD-SNMP,
agentx, and setting up traps.
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CHAPTER 1 2

Troubleshooting

This chapter provides troubleshooting information about the software and the
storage space. The chapter contains the following sections:

m “Troubleshooting Potential Software Issues” on page 159

m “Identifying a Failed or Failing Component” on page 160

m “Recovering From a Disk Drive Failure” on page 161

m “Understanding Hot-Plug Limitations and Conditions” on page 165
m “Rebuilding Logical Drives” on page 167

m “Solving Notification Problems” on page 167

m “Creating a Support Archive File” on page 168

m “Understanding Error and Warning Messages” on page 168

Troubleshooting Potential Software
Issues

If you experience problems installing or using the Sun StorageTek RAID Manager
software, follow these suggestions:

m Ensure that you are logged into the Sun StorageTek RAID Manager software at
the permission level you need to perform the tasks you want. (See
“Understanding Permission Levels” on page 20 for more information.)

m Ensure that all managed systems are powered on and that you are logged in to
any remote systems you want to manage. (See “Understanding Permission
Levels” on page 20 for more information.)

m Check all cable connections.

m Try uninstalling and reinstalling the Sun StorageTek RAID Manager software.
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Identifying a Failed or Failing
Component

When a Warning- or Error-level event occurs, use the rapid fault isolation feature of
the Sun StorageTek RAID Manager software to quickly identify the source of the
problem.

For instance, in this example, a disk drive has failed. To find the failed disk drive,
follow the yellow Error icons.
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FIGURE 12-1 Using Icons to Identify Failures
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Recovering From a Disk Drive Failure

When a disk drive fails for any reason, it is represented in the Sun StorageTek RAID
Manager software with a red X.
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This section explains how to recover when a disk drive fails:

m If the logical drive was protected by a hot-spare (see “Failed Disk Drive Protected
by a Hot-Spare” on page 162).

m If the logical drive was not protected by a hot-spare (see “Failed Disk Drive Not
Protected By a Hot-Spare” on page 163).

m If there is a disk drive failure in more than one logical drive simultaneously (see
“Failure in Multiple Logical Drives Simultaneously” on page 164).

m If it is a RAID 0 logical drive (see “Disk Drive Failure in a RAID 0 Logical Drive”
on page 164).

m If multiple disk drives fail within the same logical drive (see “Multiple Failures in
the Same Logical Drive” on page 165).

Failed Disk Drive Protected by a Hot-Spare

When a logical drive is protected by a hot-spare, if a disk drive in that logical drive
fails, the hot-spare is automatically incorporated into the logical drive and takes over
for the failed drive.

For instance, when a disk drive fails in the RAID 5 logical drive, the logical drive is
automatically rebuilt (its data is reconstructed) using the hot-spare in place of the
failed drive.

Note — In this example, the color of the hot-spare changed from light-blue to dark-
blue, showing that it is now part of a logical drive.
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V¥ To Recover From the Failure

1. Remove and replace the failed disk drive (following the manufacturer
instructions).

2. If copyback is not enabled, do the following;:

a. Remove the “hot spare’ designation from the original hot-spare (the disk
drive that was built into the logical drive).

See “To Remove or Delete a Dedicated Hot-Spare” on page 91 for instructions.
b. Designate a new hot-spare to protect the logical drives on that HBA.

3. If copyback is enabled, no action is required.

Data is automatically moved back to its original location once the HBA detects
that the failed drive has been replaced.

See “To Enable Copyback” on page 93 for more information.

Failed Disk Drive Not Protected By a Hot-Spare

When a logical drive is not protected by a hot-spare, if a disk drive in that logical
drive fails, remove and replace the failed disk drive. The HBA detects the new disk
drive and begins to rebuild the logical drive.

For instance, when one of the disk drives fails in the RAID 1 logical drive shown in
the next example, the logical drive is not automatically rebuilt. The failed disk drive
must be removed and replaced before the logical drive can be rebuilt.
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V¥ To Recover From the Failure

1. If the HBA fails to rebuild the logical drive, check that the cables, disk drives,
and HBAs are properly installed and connected.

2. If necessary, follow the instructions in “Rebuilding Logical Drives” on page 167.

Failure in Multiple Logical Drives Simultaneously

If a disk drive fails in more than one logical drive at the same time (one failure per
logical drive), and the logical drives have hot-spares protecting them, the HBA
rebuilds the logical drives with these limitations:

m A hot-spare must be of equal or greater size than the failed disk drive it’s
replacing.

m Failed disk drives are replaced with hot-spares in the order in which they failed.
(The logical drive that includes the disk drive that failed first is rebuilt first,
assuming an appropriate hot-spare is available—see the previous bullet.)

V¥ To Troubleshoot the Failures

@ If there are more disk drive failures than hot-spares, see “Failed Disk Drive Not
Protected By a Hot-Spare” on page 163.

® If copyback is enabled, data is moved back to its original location once the
HBA detects that the failed drive has been replaced.

See “To Enable Copyback” on page 97 for more information.

Disk Drive Failure in a RAID 0 Logical Drive

Because RAID 0 volumes do not include redundancy, if a disk drive fails in a RAID
0 logical drive, the data can’t be recovered.

Correct the cause of the failure or replace the failed disk drives. Then, restore your
data (if available).
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Multiple Failures in the Same Logical Drive

Except in RAID 6 and RAID 60 logical drives (see “RAID 6 Logical Drives” on
page 186), if more than one disk drive fails at the same time in the same logical
drive, the data can’t be recovered.

Correct the cause of the failure or replace the failed disk drives. Then, restore your
data (if available).

Note — In some instances, RAID 10 and RAID 50 logical drives may survive multiple
disk drive failures, depending on which disk drives fail. See “Selecting the Best
RAID Level” on page 177 for more information.

Removing the Icon of a Failed Disk Drive

Note — You can only complete this task on disk drives that are not included in any
logical drive.

When a disk drive fails, it may still be displayed in the Sun StorageTek RAID
Manager software although it is no longer available. To see an accurate
representation of your storage space and make it easier to monitor your disk drives,
you can remove a failed disk drive from the Physical Devices View.

In the Physical Devices View, right-click the failed disk drive, then click Remove
failed drive.

Understanding Hot-Plug Limitations
and Conditions

Hot-plugging of hard disk enclosures is not supported from the Sun StorageTek
RAID Manager graphical user interface (GUI). However, hot-plugging of SAS/SATA
hard disk drives (HDDs) is supported through the GUI, but only within hard disk
enclosures under the following conditions:

m “Hot-Unplug Removal Conditions” on page 166
m “Hot-Plug Addition Conditions” on page 166
m “Hot-Unplug and Plug Replacement/Reinsertion Conditions” on page 166
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Hot-Unplug Removal Conditions

Hot-unplug, removal, of HDDs is supported under the following conditions:

m After the HDDs are removed, you must wait until the configuration change is
detected and displayed within the GUI before performing any additional action to
the new physical device configuration of the HBA.

m You can continue to configure the storage space.

Hot-Plug Addition Conditions

Hot-plug, add, of HDDs is supported under the following conditions:

m After all HDDs are added to the enclosure, you must wait until the configuration
change is detected and displayed within the GUI before performing any
additional action to the new physical device configuration of the HBA.

m You can continue to configure the storage space.

Hot-Unplug and Plug Replacement/Reinsertion
Conditions

Hot unplug and plug, replace/reinsert, of HDDs is supported under the following
conditions:

m If a hard disk drive is to be removed and replaced either into the same slot or a
different unused slot using the same disk drive or a new disk drive, you must
wait until the configuration change is detected and displayed within the GUI
before performing any additional action to the new physical device configuration
of the HBA:

a. Remove the selected hard disk drive.
b. Confirm that the GUI detects and displays the new configuration.

c. Replace/reinsert the hard disk (new or same) into an enclosure slot (same or
another unused slot).

d. Confirm that the GUI detects and displays the new configuration.

m You can continue to configure the storage space.
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Rebuilding Logical Drives

A hot-swap rebuild occurs when an HBA detects that a failed disk drive in a logical
drive has been removed and then reinserted.

V¥ To Start a Hot-Swap Rebuild

1. Following the manufacturer instructions, gently pull the failed disk drive from
the server without fully removing it.

2. Wait for the disk drive to spin down fully before continuing.

3. If there is nothing wrong with the disk drive, reinstall it, following the
manufacturer instructions.

If necessary, replace the failed disk drive with a new disk drive of equal or larger
size.

4. The HBA detects the reinserted (or new) disk drive and begins to rebuild the
logical drive.

Solving Notification Problems

To test notifications on your storage space, you can send test events or emails to
ensure that they’re being received properly.

V¥ To Troubleshoot a Failed Test Event

1. Ensure that the remote system is powered on and running the Sun StorageTek
RAID Manager software.

2. Open the remote system’s System Properties window (see Step 3) and double-
check the TCP/IP address and port number.

3. Try sending the test event again.

If the test email fails:
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a. Ensure that the email address of the recipient is correct.
See “To Modify Information About a Recipient” on page 113 to modify the
address.

b. Ensure that the SMTP server address is correct.
See “To Change the Email Notification Manager Settings” on page 116 to
modify the address.

c. Try sending the test message again.

Creating a Support Archive File

Your Sun StorageTek RAID Manager software service representative might ask you
to create a configuration and status information archive file to help diagnose a
problem with your system.

V¥ To Create the Archive File

1. In the Enterprise View, click the local or remote system on which the problem
is occurring.

2. In the menu bar, select Actions, then click Save support archive.

3. Enter a name for the archive file or accept the default name, then click Save.

Understanding Error and Warning
Messages

This section provides detailed information about error and warning events that
occur in the Sun StorageTek RAID Manager software.
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Warning Messages

TABLE 12-1 Warning Messages

Warning Warning Message Text

ArrayCritical Ready disk drives are still available
HotSpareTooSmall The hot-spare is too small to protect the specified array

HotSpareWontWork At least one logical drive is not protected by the specified hot-spare

InitLD Hot-spare is too small for use by at least one array
NoService The specified logical drive was not initialized
SyncLD Could not contact the Sun StorageTek RAID Manager Agent. The

Sun StorageTek RAID Manager software may not function correctly.
Please start the Agent.

Error Messages

TABLE 12-2 Error Messages

Error Error Message Text

AbortTask Could not stop the specified currently running task

AccessControl Could not write the logical drive access control list

AddToDiskSet Could not add drives to the specified diskset

AgentRemoved Could not remove the specified Agent

ArrayInUse Could not delete the specified array. One or more initiators
are logged into a logical drive(s) contained within this
array

ArraysInUse Could not delete all of the specified arrays. One or more

initiators are logged into a logical drive(s) contained
within this array

BreakRemoteMirror Could not break the specified remote mirror facet
CalibrateBatteryController Could not recalibrate the specified battery
ChangeArraylName Could not change the name of the specified array
ChangeBIOSMode Could not change the BIOS-compatibility mapping
ChangeDiskSetName Could not change the name of diskset
ChangeLogicalLun Could not change the LUN of the specified logical drive
ChangeLogicalName Could not change the name of the specified logical drive
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TABLE 12-2 Error Messages

Error (Continued)

Error Message Text (Continued)

ChangeNtpServer
ChangeTimeDate
ChgAlarm
ChgDataScrubRate
ChgRebuildRate
ChgSCSIXferSpeed
ChgStripeSize
ChgTaskPriority
ClearAdapterLogsFail
ClearEnclosureLogsFail
ClearHardDrive

CommFailure

CommPFailurel

ControllerRescan
ControllerRestart
ControllerShutDown
CreateDiskSet
CreateLDError
CreateSimpleVolume
DataScrub

DDDAdInternal
DDDDeviceNotFound
DDDDeviceNotReady
DDDDriveAddedToSystem
DDDDriveNotBelong1
DDDDriveNotBelong?2
DDDDriveNotFound
DDDDriveNotPartOfCluster
DDDHardwareError

Could not update the specified NTP server

Could not change the date and time

Could not change the alarm setting

Could not change the background consistency check rate
Could not change the rebuild rate

Could not change the SCSI transfer speed

Could not change the specified stripe size

Could not change task priority

Could not clear the event logs for the specified system
Could not clear the event logs for specified enclosure
Clear failed to start for the specified disk drive

You must re-establish communication with specified
system

Restart the Sun StorageTek RAID Manager Agent to
establish communication with the local system

Could not rescan for the specified controller

Could not restart the specified controller

Could not shut down the specified controller

Could not create the diskset

There was an error creating specified logical drive

Could not create a simple volume

Could not change the background consistency check mode
Failed drive—Controller internal failure

Failed drive—Device not found

Failed drive—Specified device will not come ready

Failed drive—Specified disk drive added to server

Failed drive—Specified disk drive does not belong

Failed drive—Specified disk drive does not belong

Failed drive—Specified disk drive not found

Failed drive—Specified disk drive is not part of the cluster

Failed drive—Internal hardware error
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TABLE 12-2 Error Messages

Error (Continued)

Error Message Text (Continued)

DDDInternalHW
DDDIOSubSystem1
DDDIOSubSystem?2
DDDIOSubSystem3
DDDSCSI1

DDDSCSI2

DDDSCSI3
DDDSCSIBusParity
DDDSCSIBusTest
DDDSCSIChanNotOperational
DDDSCSIErrUnknown
DDDUnknownDriveFound
DDDUnknownDriveInCluster
DDDUnknownSASError
DDDUserAcceptedInitChange
DDDUserMarked
DDDUserMarkedFailed
DeleteArray

DeleteArrays
DeleteDiskSet
DeleteHArray
DeleteLogDrive
DisCopyBackMode
DisReadCache
DisUnattendedMode
DisWriteCache
EnclosureRestart
EnclosureShutDown
EnCopyBackMode
EnReadCache
EnUnattendedMode
EnWriteCache

EventNotSent

Failed drive—Internal hardware error

Failed drive—I/O subsystem error

Failed drive—I/O subsystem error

Failed drive—I/O subsystem error

Failed drive—SCSI error

Failed drive—SCSI error

Failed drive—SCSI error

Failed drive—SCSI bus parity error

Failed drive—SCSI bus test error

Failed drive—SCSI channel is not operational
Failed drive—Unknown SCSI error

Failed drive—Unknown disk drive on controller
Failed drive—Unknown disk drive in cluster
Failed drive—Unknown SAS error

Failed drive—User accepted

Failed drive—User marked 'failed’

Failed drive—User marked 'failed’

Could not delete the specified array

Could not delete all of the specified arrays
Could not delete the diskset

Could not delete the specified spanned array
Could not delete the specified logical drive
Could not disable copy back mode

Could not disable read cache

Could not disable unattended mode

Could not disable write cache

Could not restart the specified enclosure
Could not shut down the specified enclosure
Could not enable copy back mode

Could not enable read cache

Could not enable unattended mode

Could not enable write cgcqr?g ter 12 Troubleshooting

Could not send the event to the system
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TABLE 12-2 Error Messages

Error (Continued)

Error Message Text (Continued)

FailedSelfTest

FailedSelfTestStart

FailedToConnect

FailedToReadNOT
FailedToReadSEC

Faillncompatible

FailOver
FailoverDiskSet
HostList

HotSwap

ImageSelect
ImportConfig
ImportedArray
IncreaseLogDrive
InitHardDrive
InitLogDrive
KillOtherController
LDM

LogIn

LogOut
MaybeReadCache

MaybeWriteCache

MergeOwnNS

Rebuild
RemoveAHS

RemoveSHS

Specified self-test problem code was returned from
specified controller, channel, SCSI ID, S/N

One or more of the selected disk drives failed to execute
the self-test. View the RaidErrA.log file on the Sun
StorageTek RAID Manager Agent for details

Failed to connect to specified host name at specified port
number

Failed to read the notification list file
Failed to read the user accounts file

Failed to connect to the specified host name due to
incompatible software versions

Could not fail from the active device to the passive device
Could not move diskset
Could not write the host initiator list

Could not enable the automatic rebuild on replacement
operation

Could not change the firmware to the specified boot image
Could not copy the configuration from the specified drives
Could not import the specified array

Could not increase the size of the specified logical drive
Could not initialize the specified disk drive

Could not initialize the specified logical drive

Could not kill other controller

Could not start the specified logical drive reconfiguration
The user could not be logged in

The user could not be logged out

Could not set read cache mode to 'enabled when protected
by battery'

Could not set write cache mode to 'enabled when
protected by battery'

Could not copy the configuration from the non-shared
logical drives

Could not set the drive to the specified rebuild state

Could not delete the dedicated hot-spare drive
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TABLE 12-2 Error Messages

Error (Continued)

Error Message Text (Continued)

SetContDiskCachePolicy
SetHostId
SetITNexusLossTime
SetMergeGroup
SetPartnerld
SetSpareSet
SetToAHotSpare
SetToDefunct
SetToEmpty
SetToHotSpare
SetToOnline
SetToSHotSpare
SetWce

SyncArray
SyncLogDrive
TargetInfo

Unblock
UnkillOtherController
UserAccounts
VerifyArray
VerifyFixHardDrive
VerifyHardDrive

VolumelnUse

Could not change the specified global drive cache policy
Could not set the specified controller name

Could not change I_T nexus loss time

Could not set the specified merge-group number
Could not set the specified partner controller name
Could not change the specified spare set attribute
Could not create a dedicated hot-spare drive
Could not set the specified drive to failed

Could not remove the specified failed drive

Could not create a hot-spare drive

Could not set the specified failed drive to optimal
Could not create a standby hot-spare drive

Could not change the write-cache mode

Could not start the array verify

Could not start the logical drive verify

Could not write the logical drive target information
Could not unblock the specified logical drive
Could not unkill other controller

Could not write the target user account list

Could not start the array verify

Verify with fix failed to start

Verify failed to start

Could not delete the specified logical drive. One or more
initiators are logged into the logical drive.
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APPENDIX A

Selecting the Best RAID Level

When you create logical drives in the Sun StorageTek RAID Manager software, you
can assign a RAID level to protect your data.

Each RAID level offers a unique combination of performance and redundancy. RAID
levels also vary by the number of disk drives they support.

This chapter provides a comparison of all the RAID levels supported by the Sun
StorageTek RAID Manager software, and provides a basic overview of each to help
you select the best level of protection for your storage system.

The chapter contains the following sections:

m “Comparing RAID Levels” on page 178

m “Understanding Drive Segments” on page 178

m “Nonredundant Logical Drives (RAID 0)” on page 179

m “RAID 1 Logical Drives” on page 180

s “RAID 1 Enhanced Logical Drives” on page 180

m “RAID 10 Logical Drives” on page 181

m “RAID 5 Logical Drives” on page 182

s “RAID 5EE Logical Drives” on page 183

m “RAID 50 Logical Drives” on page 184

m “RAID 6 Logical Drives” on page 186

m “RAID 60 Logical Drives” on page 187
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Comparing RAID Levels
Use this table to select the RAID levels that are most appropriate for the logical
drives on your storage space, based on the number of available disk drives and your

requirements for performance and reliability.

TABLE A-1  RAID Levels

Read Write Built-in Hot- Minimum
RAID Level Redundancy Disk Drive Usage Performance Performance Spare Disk Drives
RAID 0 No 100% QQQ QQQ No 2
RAID 1 Yes 50% QQ QQ No 2
RAID 1E Yes 50% QQ QQ No 3
RAID 10 Yes 50% QQ QQ No 4
RAID 5 Yes 67% — 94% QQQ Q No 3
RAID 5EE Yes 50% — 88% QQQ Q Yes 4
RAID 50 Yes 67% — 94% QQQ Q No 6
RAID 6 Yes 50% — 88% QQ Q No 4
RAID 60 Yes 50% — 88% QQ Q No 8
Spanned Volume No 100% QQQ QQQ No 2
RAID Volume No 50% — 100% QQQ QQQ No 4

Disk drive usage, read performance, and write performance depend on the number
of drives in the logical drive. In general, the more drives, the better the performance.

More information about each RAID level is available beginning with “Nonredundant
Logical Drives (RAID 0)” on page 179.

Understanding Drive Segments

A drive segment is a disk drive or portion of a disk drive that is used to create a
logical drive. A disk drive can include both RAID segments (segments that are part of
a logical drive) and available segments. Each segment can be part of only one logical
drive at a time. If a disk drive is not part of any logical drive, the entire disk is an
available segment.
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FIGURE A-1
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Nonredundant Logical Drives (RAID 0)

A logical drive with RAID 0 includes two or more disk drives and provides data
striping, where data is distributed evenly across the disk drives in equal-sized
sections. However, RAID 0 arrays do not maintain redundant data, so they offer no
data protection.

Compared to an equal-sized group of independent disks, a RAID 0 array provides
improved I/O performance.

Drive segment size is limited to the size of the smallest disk drive in the logical drive.
For instance, a logical drive with two 250 GB disk drives and two 400 GB disk drives
can create a RAID 0 drive segment of 250 GB, for a total of 1000 GB for the volume,
as shown in this figure.
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RAID 1 Logical Drives

A RAID 1 logical drive is built from two disk drives, where one disk drive is a mirror
of the other (the same data is stored on each disk drive). Compared to independent
disk drives, RAID 1 logical drives provide improved performance, with twice the
read rate and an equal write rate of single disks. However, capacity is only 50 percent
of independent disk drives.

If the RAID 1 logical drive is built from different-sized disk drives, drive segment
size is the size of the smaller disk drive, as shown in this figure.

FIGUREA-2 RAID 1 Logical Drives

Disk Drve 1

Disk Drive 2

Drve Segment 3ize (Smallest
Disk Drive)

TR i /
e e Disk Drive 1

400 GB Disk Drive 2

Unused Space = 130 GB

Disk Drives in Logical Drive RAID 1 Logical Drive = 250 GB

RAID 1 Enhanced Logical Drives

A RAID 1 Enhanced (RAID 1E) logical drive—also referred to as a striped mirror—is
similar to a RAID 1 logical drive except that data is both mirrored and striped, and
more disk drives can be included. A RAID 1E logical drive can be built from three or
more disk drives.

In this figure, the large bold numbers represent the striped data, and the smaller,
non-bold numbers represent the mirrored data stripes.
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FIGURE A-3

RAID 1 Enhanced Logical Drives
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RAID 10 Logical Drives

A RAID 10 logical drive is built from two or more equal-sized RAID 1 logical drives.
Data in a RAID 10 logical drive is both striped and mirrored. Mirroring provides data
protection, and striping improves performance.

Drive segment size is limited to the size of the smallest disk drive in the logical drive.
For instance, a logical drive with two 250 GB disk drives and two 400 GB disk drives
can create two mirrored drive segments of 250 GB, for a total of 500 GB for the logical
drive, as shown in this figure.
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FIGURE A-4 RAID 10 Logical Drives
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RAID 5 Logical Drives

A RAID 5 logical drive is built from a minimum of three disk drives, and uses data
striping and parity data to provide redundancy. Parity data provides data protection,
and striping improves performance.

Parity data is an error-correcting redundancy that’s used to re-create data if a disk
drive fails. In RAID 5 logical drives, parity data (represented by Ps in the next figure)
is striped evenly across the disk drives with the stored data.

Drive segment size is limited to the size of the smallest disk drive in the logical drive.
For instance, a logical drive with two 250 GB disk drives and two 400 GB disk drives
can contain 750 GB of stored data and 250 GB of parity data, as shown in this figure.
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FIGURE A5 RAID 5 Logical Drives
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RAID 5EE Logical Drives

A RAID 5EE logical drive—also referred to as a hot space—is similar to a RAID 5

logical drive except that it includes a distributed spare drive and must be built from a

minimum of four disk drives.

Unlike a hot-spare (see “Working With Hot-Spares” on page 87), a distributed spare

is striped evenly across the disk drives with the stored data and parity data, and

can’t be shared
speed at which

with other logical disk drives. A distributed spare improves the
the logical drive is rebuilt following a disk drive failure.

A RAID 5EE logical drive protects your data and increases read and write speeds.

However, capacity is reduced by two disk drives” worth of space, which is for parity

data and spare data.
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In this example, S represents the distributed spare, P represents the distributed parity

data.

FIGURE A-6 RAID 5EE Logical Drives
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RAID 50 Logical Drives

A RAID 50 logical drive is built from at least six disk drives configured as two or
more RAID 5 logical drives, and stripes stored data and parity data across all disk

drives in both

RAID 5 logical drives. (For more information, see “RAID 5 Logical

Drives” on page 182.)

The parity data provides data protection, and striping improves performance. RAID
50 logical drives also provide high data transfer speeds.
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Drive segment size is limited to the size of the smallest disk drive in the logical drive.
For example, three 250 GB disk drives and three 400 GB disk drives comprise two
equal-sized RAID 5 logical drives with 500 GB of stored data and 250 GB of parity
data. The RAID 50 logical drive can therefore contain 1000 GB (2 x 500 GB) of stored
data and 500 GB of parity data.

FIGURE A7 RAID 50 Logical Drives
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In this example, P represents the distributed parity data.
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RAID 6 Logical Drives

A RAID 6 logical drive—also referred to as dual drive failure protection—is similar to a
RAID 5 logical drive because it uses data striping and parity data to provide
redundancy. However, RAID 6 logical drives include two independent sets of parity
data instead of one. Both sets of parity data are striped separately across all disk
drives in the logical drive.

RAID 6 logical drives provide extra protection for your data because they can recover
from two simultaneous disk drive failures. However, the extra parity calculation
slows performance (compared to RAID 5 logical drives).

RAID 6 logical drives must be built from at least four disk drives. Maximum stripe
size depends on the number of disk drives in the logical drive.
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FIGURE A-8 RAID 6 Logical Drives
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RAID 60 Logical Drives

Similar to a RAID 50 logical drive (see “RAID 50 Logical Drives” on page 184), a

+—Unused Space = 150 GB

+—Unused Space = 150 GB

RAID 60 logical drive—also referred to as dual drive failure protection— is built from at
least eight disk drives configured as two or more RAID 6 logical drives, and stripes
stored data and two sets of parity data across all disk drives in both RAID 6 logical

drives.

Two sets of parity data provide enhanced data protection, and striping improves

performance. RAID 60 logical drives also provide high data transfer speeds.

Appendix A Selecting the Best RAID Level

187



188  Sun StorageTek RAID Manager Software User’s Guide ¢ May 2009



APPENDIX B

Frequently Asked Questions

This appendix provides quick references to frequently requested information about
basic tasks, functions, and concepts in the Sun StorageTek RAID Manager software.

Note — For troubleshooting tips, see “Troubleshooting” on page 159.

The appendix contains the following sections:

“How to Perform Common Tasks” on page 189
“About Terminology Clarifications” on page 192
“About Viewing Actions Menu Options” on page 194
“About Tasks That You Can Schedule” on page 199

How to Perform Common Tasks

This section describes how to perform common tasks with the software.

V¥ To Set Up Your Storage Space

® Follow the steps in “Getting Started Tasks” on page 1.

V¥ To Create or Add a New Logical Drive

1.

In the Enterprise View, right-click the HBA you want.

A navigational menu is displayed.
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2. Do one of the following:
» From the navigational menu, choose Create logical device.

» Click either of the buttons in the following table.

TABLE B-1 Create Buttons

Create Buttons

For more information, see “Building a Storage Space” on page 35.

V¥ To Open the Configuration Wizard
1. In the Enterprise View, right-click the HBA you want.
A navigational menu is displayed.

2. Do one of the following;:
» From the navigational menu, choose logical device.

m Click either of the buttons in TABLE B-1.

See “Building a Storage Space” on page 35.

V¥ To Turn Off an Alarm

® Do one of the following:
» Click the Silence button in the Enterprise View.

» From the menu bar, choose Actions > Agent actions > Alarm
actions > Silence alarm.

See “Silencing and Testing the Audible Alarm” on page 120.
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V¥ To Add a New User to the Software

Any user with a valid network user name and password can log into the Sun
StorageTek RAID Manager software.

See “Starting the Software” on page 16.

V¥ To Add a Remote System

® Click the Add button.

[ add

See “Logging Into Remote Systems” on page 53.

V¥ To Prevent a User From Changing Your Storage
Space

® See “Understanding Permission Levels” on page 20 for information on
restricting access.

V¥ To Check Disk Drive or Logical Drive Status

® Hold your cursor over the disk drive or logical drive to reveal status
information.

See also “Revealing More Disk Drive Information” on page 29.

V¥ To Log Out of the Software

1. In the Enterprise View, click on the local system.
2. In the menu bar, select Actions, then click Log out.

See “Logging Out of and Into the Software” on page 21.

V¥ To Schedule a Task

1. Complete each step of the task until you are prompted to click Apply. (Don’t
click Apply.)
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2. Click Schedule.

Note — The Schedule button will not be displayed for tasks that cannot be scheduled.

See “Scheduling a Task” on page 123.

V¥ To Find the Task Manager

® From the menu bar, choose Configure > system-name > Tasks.

See “Scheduling a Task” on page 123.

V¥ To Find the Notification Manager

® From the menu bar, choose Configure > system-name > Notifications.

See “Setting Up Event Notifications” on page 99.

V¥ To Find the Email Notification Manager

® From the menu bar, choose Configure > system-name > Email Notifications.

See “Setting Up Email Notifications” on page 108.

About Terminology Clarifications

This section describes the differences between terms used in the software.

Software Versus Agent

The Sun StorageTek RAID Manager software is the full software application,
including the graphical user interface (windows, menus). It helps you build and
maintain the logical drives, HBAs, and disk drives that make up your storage space.
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The agent is similar to a service that keeps your storage space running. Its job is to
monitor system health and manage event notifications, tasks schedules, and other on-
going processes on each system in your storage space. The Agent can run
independently of the full application.

See “About the Sun StorageTek RAID Manager GUI Software” on page 2 for more
information.

Internal Versus External RAID Branches of the
Enterprise View

The Internal RAID branch of the Enterprise View helps you manage the local and
remote systems in your storage space that have internal (or direct-attached)
storage—a RAID HBA and disk drives residing inside or directly attached to the
system. Internal RAID storage can only be accessed by the system to which it is
attached. This document addresses the internal RAID branch only.

FIGURE B-1 Internal RAID Branch

Local system with OR Server with RAID  Local system
EATD HEA and disk HEA and disk
drives installed drives mstalled

The External RAID branch helps you set up and manage external storage—one or
more RAID HBAs and multiple disk drives that reside in a server, and which is
shared among multiple systems on a LAN.

Appendix B Frequently Asked Questions 193



FIGURE B-2 External RAID Branch

Storage space resides here not at
individual systems.

_
{/’ L.
LAN
E
\“"“'k__,/:_'ﬂ-
Server with EATD HBA and Local System

dizk drives installed

Event Notifications Versus Email Notifications
Versus Event Alerts

Event notifications (also called logged notifications) are messages about events on
one system that are sent to the Event Viewer of another system in your storage space.
(See “Setting Up Event Notifications” on page 99.)

Email notifications are email messages about events on a system in your storage
space that are sent to specified users. (See “Setting Up Email Notifications” on
page 108.)

Event alerts are pop-up messages or console messages about all types of events on a
specific system, which are broadcast to all the users who are logged into your storage
space. (See “Broadcasting Event Alerts to Users” on page 117.)

About Viewing Actions Menu Options

This section describes the different options on the Actions menu, a commonly used
menu in the software. The options on the Actions menu change, depending on
whether you select a system, HBA, disk drive, or enclosure before accessing the
menu.
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Note — You can access many Action menu options by right-clicking a component.
For example, right-click on a system to access most of the options shown in “To View
Local and Remote System Actions” on page 195. See “About the Actions Menu” on
page 33 for more information.

V¥ To View Local and Remote System Actions

1. In the Enterprise View, click on a local or remote system.

2. From the menu bar, choose Actions.

The action options that can be applied to the selected system are displayed.
Mouse-over the Actions menu to view all the Action options. The Agent actions
option displays additional menu options.

FIGURE B-3 Action Menu Options

Actions  Help
{» Hints and tips |
Log out |
Agent actions k Configure
Save printahle cunﬂgur%inn Wiews event log
Save support archive Alarm actions

Clear logs on all controllers
Change display group »
Properies

V¥ To View HBA Actions

1. In the Enterprise View, click on an HBA.

2. From the menu bar, choose Actions.

The action options that can be applied to the selected HBA are displayed. Mouse-
over the Actions menu to view all the Action options.
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V¥ To View Disk Drive Actions

1. In the Physical Devices View, click on a disk drive.

2. From the menu bar, choose Actions.

The action options that can be applied to the selected disk drive are displayed.
Mouse-over the Actions menu to view all the Action options.

V¥ To View Enclosure Actions

1. In the Physical Devices View, click on an enclosure management device.

2. From the menu bar, choose Actions.

The action options that can be applied to the selected disk drive are displayed.
Mouse-over the Actions menu to view all the Action options.

V¥ To View Logical Drives Actions

In the Logical Devices View, click on a logical drive. In the menu bar, choose Actions
to view these options.

FIGUREB-4 Viewing Logical Drives

Actions,, Help
EF] H%\ts and tips

Clear
WErify
YWerify with fix
Expand or change logical device
Delete ogical device
Configure write cache k
Configure read cache b
Change logical device name

Create snapshot b

Fropetties
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V¥ To View Internal RAID Storage Actions

In the Enterprise View, click Internal RAID. In the menu bar, select Actions to view
these options.

FIGUREB-5 Viewing RAID Storage

Actionsy., Help
@ A%d managed system
Remove managed system #

lpdate caontroller images

Froperties

V¥ To View Notification Manager Actions

In the tool bar, click Configure, select the system you want, then click Notifications.
In the menu bar, select Actions to view these options.

FIGURE B-6 Viewing Notification Manager Options

Actionsp, Help
5 Add system
@ Delete system
E Modify system
Send test event

Disahle notifications

V¥ To View Email Notification Manager Actions

In the tool bar, click Configure, select the system you want, then click Email
Notifications. In the menu bar, select Actions to view these options.
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FIGUREB-7 Viewing Email Notification Manager Options

Actions . Help

E. Add email recipient

@ Delete ernail recipient

%. Wodify email recipient
Send fest message
SMTF serer setlings

Disable Email Motifications

V¥ To View Task Manager Actions

In the menu bar, click Configure, select the system you want, then click Tasks. In the
menu bar, select Actions to view these options.

FIGUREB-8 Viewing Task Manager Options

Actions,., Help
@ Delete task
B Modify task
/] view task
Disable Task Scheduler

About Tasks That You Can Schedule

You can schedule any of these tasks to run at a specified time:

m Changing a logical drive from one RAID level to another (see “Changing the
RAID Level of a Logical Drive” on page 83).

m Expanding the size of a logical drive (see “Increasing the Capacity of a Logical
Drive” on page 80).

m Modifying a logical drives settings (see “Fine-Tuning Logical Drives” on page 73).
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m Verifying a logical drive (see “To Verify a Logical Drive Without Fixing It” on
page 79) or verifying and fixing a logical drive (see “To Verify and Fix a Logical
Drive” on page 78).

See “Scheduling a Task” on page 123 for more information.
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APPENDIX C

Buttons and Icons At-a-Glance

This appendix provides quick references to the icons and buttons that display in the
Sun StorageTek RAID Manager software. The appendix contains the following
sections:

m “Enterprise View Icons” on page 202

m “Icons in the Physical Devices View” on page 202

m “Icons in the Logical Devices View” on page 204

m “Buttons in the Main Window” on page 205

m “Buttons in the Notification Manager” on page 207

m “Buttons in the Email Notification Manager” on page 207

m “Buttons in the Task Manager” on page 208
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Enterprise View Icons

TABLE C-1  Enterprise View Icons

Icon

Description

=

System with RAID HBA and directly attached disk drives or enclosures

Enclosure

HBA

Icons in the Physical Devices View

TABLEC-2 Physical Devices View Icons

Icon

Description

N
-

= g B B D

=

3 ®

Ready disk drive
Disk drive with free space
Disk drive with no free space

Failed disk drive

HBA battery

Healthy global or dedicated hot-spare

Hot-spare with error (see “About the Hot-Spare Icons” on page 91 for more
information)

Hot-spare being built into logical drive after disk drive failure
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TABLE C-2 Physical Devices View Icons

Hot-spare built into logical drive after disk drive failure

HBA
Enclosure Management Device
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Enclosure Status Icons

TABLE C-3 Enclosure Status Icons

Description

Icon Description Icon
Enclosure fan(s) — normal
Enclosure temperature — normal

Enclosure Power — normal

Enclosure fan(s) — warning

o

Enclosure temperature — warning

Enclosure Power — warning

= = [

Enclosure fan(s) — error
Enclosure temperature — error

Enclosure Power — error

Icons in the Logical Devices View

TABLE C-4 Logical Devices View Icons

Icon Description

@ Logical drive

[:] Logical drive with healthy hot-spare

+

Logical drive being initialized

®

2. @,

Logical drive being modified

Logical drive being rebuilt after disk drive failure

Array with available space

Array with no available space

B ®
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Buttons in the Main Window

TABLE C-5

Main Window Buttons

Button

Click to Do the Following

For More Information, See
This Section

[ add

[} Create

Q. Silence

i
T J
S
=
T
2
T
@

Q Configure.

-

@ Help

Hﬂmﬂl

Add a remote system

Create a logical drive; open the
Configuration wizard

Silence the audible alarm

Check status and other properties of a
HBA, disk drive, or other component

View the full Event log

¢ Configure the agent settings
¢ Configure notification settings
¢ Configure email notification settings

e Check the status of scheduled tasks;
monitor and modify scheduled tasks

Open the online Help

See a text description of your disk drives

See the size capacities of your disk drives

See the size capacities of your disk drives

relative to each other

Create a global hot-spare

“Logging Into Remote
Systems” on page 53

“Building a Storage
Space” on page 35

“Silencing and Testing
the Audible Alarm” on
page 120

“Viewing Component
Properties” on page 139

“To View the Full List of
Events” on page 96

e “Customizing the
Agent” on page 61

* “Setting Up Event
Notifications” on
page 99

* “Setting Up Email
Notifications” on
page 108

* “Managing Tasks” on
page 123

“Getting Help” on
page 33

“Revealing More Disk
Drive Information” on

page 29

“Revealing More Disk
Drive Information” on
page 29

“Revealing More Disk
Drive Information” on
page 29

“To Designate a Global
Hot-Spare” on page 88
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Main Window Buttons

Button (Continued)

Click to Do the Following (Continued)

For More Information, See
This Section (Continued)

(—% Logical devices

ig =] @ @&
JEEE S
o

Create a logical drive
Delete a logical drive

Expand and collapse additional
information about disk drives and logical
drives

Access logical drive-specific functions, such
as deleting

Access channel-specific functions, such as
rescanning

Access port-specific functions, such as
blinking

Access device-specific functions, such as
initializing

“Building a Storage
Space” on page 35
“Deleting a Logical
Drive” on page 86

“Revealing More Disk
Drive Information” on
page 29

“Blinking a Component”
on page 140

“Blinking a Component”
on page 140

“Blinking a Component”
on page 140

“Blinking a Component”
on page 140
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Buttons in the Notification Manager

TABLE C-6 Notification Manager Buttons

Button Click to Do the Following

For More Information, See
This Section

= agd system Add a system that will receive
notifications generated by the
Notification Manager

[ Modity system Update a system’s address, host name, or
notification level

& Delete system E?Itrlove a system from the Notification
is

“Setting Up Event
Notifications” on page 99

“Modifying the Address,
Host Name, or
Notification Level of a
System” on page 104

“Removing a System
From the Notification
List” on page 105

Buttons in the Email Notification

Manager

TABLE C-7 Email Notification Manager Buttons

Button Click to Do the Following

For More Information, See
This Section

e Add the email address of a user who
will receive notifications generated by
the Email Notification Manager

T Update a recipient’s email address or
notification level

€ Delete email recipient Remqve .a rec1P1ent from the Email
Notification List

“Setting Up Email
Notifications” on
page 108

“To Modify
Information About a
Recipient” on page 113

“To Remove a
Recipient From the
Email List” on page 113

Appendix C Buttons and Icons At-a-Glance 207



208

Buttons in the Task Manager

TABLE C-8 Task Manager Buttons

For More Information, See

Button Click to Do the Following This Section

View task View the details of a scheduled task “Monitoring Tasks” on
page 127

Modify task Reschedule a task or change the “Modifying a Task” on

description of the task in the Task List

$J Delete task Delete a task that is no longer required

page 129

“Deleting a Task” on
page 131
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Glossary

A

agent

available space

B

background consistency
check

C

channel

controller

copyback

Runs in the background on your system, monitoring and managing event
notifications, tasks schedules, and other on-going processes in your storage
space. It requires no user intervention and includes no user interface.

Space on a disk drive that is not being used by a logical drive. When a
logical drive is deleted, its space becomes available.

A HBA function that continually and automatically verifies your logical
drives once they’re in use.

Any path used for the transfer of data and the control of information
between disk drives and a RAID HBA.

See HBA.

RAID HBA feature that allows data that has been moved to a hot-spare to
be returned to its original location once the controller detects that the failed
drive has been replaced.
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D

DAS

dual drive failure
protection

E

Email Notification
Manager

email notifications

event

F

fault tolerance

firmware

GB

Direct-attached Storage. Data storage that is physically connected to a
server.

Another name for a RAID 6 or RAID 60 logical drive.

A utility within the Sun StorageTek RAID Manager software that emails
event messages to selected recipients.

Event messages about remote systems that are emailed to selected recipients.

Activity on your storage space, such as a disk drive failure or logical drive
verification.

The ability of a system to continue to perform its functions even when one
or more disk drives have failed.

A combination of hardware and software; software written onto read-only
memory (ROM).

GigaByte. 1,024 MB.
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H

HBA

host

host bus adapter (HBA)
hot space

hot-spare

hot-swap

initialize

I/0

LAN

LED

local system

logged notifications

logical drive

A hardware device that interprets signals between a host and a disk drive.
Also known as an adapter or card.

A system that’s connected to a TCP/IP network.

An adapter card that includes all of the I/O logic, software, and processing
to manage the transfer of information between the host and the devices it’s
connected to.

A RAID 5EE logical drive.

A spare disk drive which will automatically replace a failed disk drive in a
logical drive.

Remove and replace a failed disk drive in a logical drive without shutting
down the server or disrupting activity on the logical drive.

Prepare a disk drive for reading and writing.

Input/Output. Data entering into or being extracted from a system.

Local Area Network. A network of interconnected workstations sharing the
resources of a single server, typically within the area of a small office
building.

Light-Emitting Diode. An electronic device that lights up when powered.

The computer (or system) that you're working on. In the Sun StorageTek
RAID Manager software, ‘local’ and ‘remote” are relative terms.

Event messages about remote systems that appear in the Event Viewer of the
Sun StorageTek RAID Manager software.

One or more disk drives grouped together to appear as a single device to an
operating system. Also known as a logical device or array.
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M

managed system

MB

mirroring

N

Notification Manager

P

parity

partition

A computer (or system) in a storage space that’s being managed by the Sun
StorageTek RAID Manager software.

MegaByte. Depending on context, 1,000,000 or 1,048,576 bytes. Also 1000 KB.

Data protection that duplicates all data from one drive onto a second drive.

A utility within the Sun StorageTek RAID Manager software that broadcasts
event messages to selected managed systems.

A form of data protection used by some RAID levels to re-create the data of
a failed disk drive in a logical drive.

Divides the space of a disk drive into isolated sections.

port

A connection point to a disk drive, expander, enclosure, or other device.

R

RAID
rapid fault isolation

rebuild

Redundant Array of Independent Disks. For more information on RAID and
all supported RAID levels, see “Selecting the Best RAID Level” on page 177.

The trail of yellow or red warning icons that leads from the high-level
system view to the failed or failing component.

Re-create a logical drive after a disk drive failure.
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recurring task

redundancy

remote system

ROM Update wizard

SAN

scheduled task

segment

SMTP

storage space

stripe size

striped mirror

striping

T

Task Manager

TB

A scheduled task, such as logical drive verification, that occurs on a regular
basis.

The capability of preventing data loss if a disk drive fails.

In the Sun StorageTek RAID Manager software, all other systems in your
storage space besides your local system are remote systems. ‘Local” and
‘remote’ are relative terms.

A program that updates the BIOS and firmware codes on the HBA.

Storage Area Network. A storage architecture that connects servers and disk
drives across a network for enhanced reliability, scalability, and
performance.

Activity, such as logical drive verification, that is set to be completed at a
specified date and time.

Disk drive space that has been assigned to a logical drive. A segment can
include all or just a portion of a disk drive’s space.

Simple Mail Transfer Protocol.

The HBA(s) and disk drives being managed with the Sun StorageTek RAID
Manager software.

Amount of data written to one partition before the HBA moves to the next
partition in a stripe set.

A RAID 1 Enhanced, or RAID 1E, logical drive.

A method of enhancing performance by spreading data evenly over multiple
disk drives. Provides no data protection.

A utility in the Sun StorageTek RAID Manager software that allows you to
schedule a specific activity, such as expanding a logical drive, for a time
that’s convenient.

TeraByte. Approximately one million-million bytes, or 1024 GB.
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TCP/IP Transmission Control Protocol/Internet Protocol. A set of communication
protocols used to connect hosts on the Internet.

verify Check a logical drive for inconsistent or bad data. May also fix any data
problems or parity errors.
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Index

A log in, 22

about log out, 22
advanced storage space, 5 logical drive-level options, 196
agent, 3 notification manager options, 197
simple storage space, 4 overview, 33,194 to 198
software, 2 remove dedicated hot-spare drive, 91

actions menu, 33 rescan, .146 ' '
agent actions, 122 save printable configuration, 147

alarm. 121,122 save support archive, 168
’ ! send test event, 102

email notifications, 112
send test message, 112

notifications, 102 " )
alarm actions, 121,122, 145, 146 set drive state to failed, 142
change logical device name, 73 SMTP server sett.mgs, 116
clear logs on all controllers, 97 system-level options, 195
configure read cache, 76 task manager options, 198
configure write cache, 75 update controller images, 151
controller-level options, 195 ver%fy, 7.9 )
create dedicated hot-spare drive, 89 verify with fix, 78

delete dedicated hot-spare drive, 91 Adaptec Storage Manager
delete hot-spare drive, 92 operating system support, 8
delete logical device, 86 system requirements, 8
disable email notifications, 117 adapters. See controllers
disable notifications, 107 ADDLOCAL, 12

disable task scheduler, 132 administrator permissions, 20

disk drive-level options, 196

email notification manager options, 198
ble (disable) back d ist

enable (disable) background consistency Agent, 3
check, 80 ntroducti 3

enclosure-level options, 196 mtroduction,

advanced settings, 44, 74
advanced storage space, 5

expand or change logical device, 73,74, 81, 83 agent, 3

initialize, 143 alarm settings, 63
initialize all ready drives, 143 broadcgsﬁ event alerts, 62
internal RAID branch-level options, 197 customizing, 61
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event log, 62 RAID Volumes, 47

port number, 65 buttons

starting main window, 205 to 208
Linux, 18 notification manager, 207
Solaris, 19 rmail notification manager, 207
Windows, 18 task manager, 208

alarm
changing settings, 63 C
controllers cards. See controllers

disabling, 146

silencing, 145

testing, 145
disabling, 64

controller-level, 146

enclosure-level, 149

system-level, 121
duration, 64

clear (initialize method), 76
components

blinking, 140

defined, xxvi

identifying, 140

viewing properties, 139
configuration event detail window, 96

enabling (system-level), 121 configure button, 100
enclosures configuring, 35
disabling, 149 See also building storage space
silencing, 149 continuing to grow storage space, 6
testing, 148 controllers
frequency, 64 actions menu, 195
systems blinking, 140
disabling, 121 disabling alarm, 146
enabling, 121 identifying, 140
silencing, 122 properties, 139
testing, 122 registering, 144
testing rescanning, 146
controller-level, 145 saving configurations, 147
enclosure-level, 148 support by operating system, 51
system-level, 122 testing alarm, 145
archive file, 168 copyback, 93
audible alarm. See alarm custom configuration, 40
automatic verification, 77
D
B daemon, 3
background consistency check, 77, 80 DAS. See internal RAID storage
background verification, 77 dedicated hot-spares, 87
base port number, 65 creating, 89
blinking components, 140 deleting, 91
boards. See controllers removing, 91
broadcasting event alerts, 117 deleting logical drives, 86
build (initialize method), 76 devic.es,. 25
building storage space, 35 to 52 blinking, 140 .
custom configuration, 40 direct-attached storage. See internal RAID storage
express configuration, 36 disabling alarm
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enclosure-level, 149
system-level, 121
disk drive segments, 178
disk drives
actions menu, 196
available space, 27
blinking, 140
capacity, 30
conceptual graphic, 67

different sizes in same logical drive, 70

failed state, 142

failure recovery
multiple disk drives, 165
multiple logical drives, 164
RAID 0 logical drives, 164
with hot spare, 162
without hot-spare, 163

identifying, 140

initializing, 142

properties, 139

relative capacity, 31

replacing in logical drives, 141

segments in logical drives, 71

viewing logical drives, 29

viewing status, 27

within logical drives, 41

display groups, 56

adding systems, 133

creating, 56

deleting, 137

moving systems, 135

removing systems, 137

renaming display groups, 136

system status, 134

distributed spare drives, 183

E

email event detail window, 114
email list, 113
modifying users, 113
removing users, 113
sending test emails, 112
email log, 114
clearing, 115

email notification manager, 108 to 117

actions menu, 198
buttons, 207
clearing the email log, 115

disabling, 116
email list, 113
email log, 114
email notifications, 108
failed test emails, 113
modifying settings, 116
opening, 108
re-enabling, 117
test emails, 112
email notifications, 108
changing "from" address, 116
changing SMTP server, 116
email list, 113
email log, 114
failed test emails, 113
modifying users, 113
removing users, 113
sending test emails, 112
SMTP server settings, 110
email notifications tab, 109
enclosure view, 30
enclosures
actions menu, 196
blinking, 140
disabling alarm, 149
identifying, 140
monitoring, 118
silencing alarm, 149
status icons, 32,118
testing alarm, 148
enterprise view, 24
display options, 59
icons, 202

internal RAID vs external RAID branches, 193

sorting systems, 59
error (task status), 128
event alerts, 117
event log, 96

clearing, 97
event log (operating system), 62
event notifications, 99

adding systems, 100

event viewer, 99, 194

failed test events, 103

introduction, 99

logged notifications, 99

modifying systems, 104

Index

217



notification list, 101
notification log, 105
removing systems, 105
sending test events, 102
sources of events, 99
event viewer, 31
event notifications, 99, 194
logged notification status, 106
logged notifications, 99
sources of events, 99
status icons, 98
events, 31
sources, 99
status icons, 98, 106
events button, 96
executed (task status), 127
executed” (task status), 127
expanding logical drives, 80
express configuration, 36
RAID levels, 36
external RAID storage, 193

F

failed disk drives
multiple disk drives, 165
multiple logical drives, 164
RAID 0 logical drives, 164
without hot-spare, 163

fans status icon, 118

distributed spare drives, 183
hot-spares, 27, 87 to ??

creating, 88

creating dedicated, 89

creating pool, 89

dedicated, defined, 87

deleting, 91

global, defined, 87

limitations, 87

removing, 91

|
icons, 202 to 204

enterprise view, 202

logical devices view, 204

physical devices view, 202
ICP Storage Manager

Agent, 3

operating system support, 8

system requirements, 8
identifying components, 140
initialize method, 76
initialize priority, 76
initializing disk drives, 142
installation

Solaris OS, 14

VMWare OS, 15

INSTALLDIR, 12
installing

FAQs, 189 Linux OS, 13
formatting logical drives, 39 on the Solaris OS, 14
email notifications on the VMWare OS, 15

"from" address, 110
full size capacity view, 30

G

getting started, 1

global hot-spares, 87
deleting, 92

guest permissions, 21

silent Windows OS, 11

software, 9

Windows OS, 10
installing software, 9 to 15

Linux, 13

Solaris, 14

VMWare, 15

Windows

silent installation, 11

internal RAID storage

H actions menu, 197

hard disk, hard disk drive, hard drive. See disk drive actions menu introduction, 33
HBASs. See controllers actions menu overview, 194 to 198
help, 33 comparing to external RAID, 193
hot spares introduction
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agent, 3
software, 2

J
JBODs. See enclosures
jobs. See tasks

L

Linux
controller support, 51
installing, 13
SNMP support, 157
starting software, 17
starting the agent, 18
Linux OS installation, 13
local systems, 53
log files, clearing, 106, 115
logged notifications. See event notifications
logging in
permission levels, 20
logging out, 21
logical devices view, 27
icons, 204
logical devices. See logical drives
logical drives, 27, 67 to 87
actions menu, 196
advanced settings, 44, 74
automatic verification, 77
available space on disk drives, 70
background consistency check, 77
background verification, 77
building
advanced, 40
basic, 36

changing background task priority, 38

stop building, 38
changing RAID levels, 83
custom configuration, 40
defined, 67
definition, 163
deleting, 86
different-sized disk drives, 70

disabling background consistency check, 80

disk drive segments, 71,178
distributed spare drives, 183

enabling background consistency check, 80

expanding, 80

extending partitions, 83
fine-tuning, 73 to 76
formatting, 39
increasing capacity, 80
initialize method, 76
initialize priority, 76
manual verification, 77
maximum size, 80
mirrored data, 180
non-redundant, 179
options for creating, 35
parity, 182
partitioning, 39
RAID 1, 180
RAID 10, 181
RAID 1E, 180
RAID 5, 182
RAID 50, 184
RAID 5EE, 183
RAID 6, 186
RAID 60, 187
RAID level, 28
RAID segments, 178
RAID Volumes, 47
read cache, 75
rebuilding, 162, 167
remove disk drive or segment, 81
renaming, 73
replace disk drive or segment, 81
replacing disk drives, 141
selecting disk drives, 41
selecting RAID levels, 41
setting the size, 69
size, 43

limitations, 46
stripe size, 74
striping data, 179
verifying, 77,79
verifying and fixing, 78
verifying icon, 79
viewing disk drives, 28
viewing status, 28
write cache setting, 75

main window, 23

display options, 61
overview, 23
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manual verification, 77 Linux, 17

mirroring, 180 Solaris, 17

monitoring opening the software
clearing event log, 97 Windows, 16
component properties, 139 operating system event log, 62
email notification manager, 108 operating system support, 8
email notifications, 108 overview
event notifications, 99 agent, 3

full event log, 96

software, 2
introduction, 95

notification manager, 99 P
status icons, 98, 106 .
tasks, 127 parity, 182

partitioning logical drives, 39
N partitions, 83
permission levels, 20

physical devices view, 26
icons, 202

pool hot-spares, 89

non-redundant logical drives, 179
notification event detail window, 106
notification list, 101

adding systems, 100

modifying systems, 104 port number, 65

removing systems, 105 power status icon, 118

sending test events, 102 properties button, 139
notification log, 105

clearing, 106 Q

status icons, 106 quick (initialize method), 76
notification manager, 99 to ??

actions menu, 197 R

buttons, 207 RAID

clearing the log, 106 distributed spare drives, 183

disabling, 107 mirrored data, 180

event notifications, 99 non-redundant logical drives, 179

fall?c.l test ersnts, 103 parity, 182

notification list, 101 RAID 0, 179

notification log, 105 RAID 1, 180

opening, 100 RAID 10, 181

re-enabling, 108 RAID 1E, 180

test events, 102 RAID 5, 182
notifications, 99 to 118 RAID 50, 184

email notifications, 99, 108 RAID 5EE, 183

event alerts, 117 RAID 6, 186

event notifications, 99 stripe size, 75

introduction, 99 RAID 60, 187
notifications tab, 100 stripe size, 75

striping data, 179

(0] RAID controller support, 51
online help, 33 RAID levels
opening software changing, 83
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custom configuration, 41
express configuration, 36
selecting, 41
RAID segments, 178
RAID Volumes, 47
RaidCfg.log file, 148
read cache, 75
REBOOT, 12
rebuilding (defined), 162, 163
rebuilding logical drives, 167
recurring tasks, 123

Redundant Array of Independent Disks. See RAID

registering new controllers, 144
relative size capacity view, 31
remote systems, 53

logging in, 53

removing, 56

startup port number, 55
renaming logical drives, 73
rescanning controllers, 146
ROM update wizard, 150
running software

Linux, 17

Solaris, 17

Windows, 16

S
scheduled (task status), 127
scheduling tasks, 123
rescheduling, 130
supported tasks, 123
changing RAID level, 85
expanding logical drives, 82
modifying logical drives, 74
verifying, 79
verifying with fix, 78
See also tasks
segments, 68,178
silencing alarm
controller-level, 145
enclosure-level, 149
system-level, 122
silent installation, 11
simple storage space, 4
size limitations for logical drives, 46

size of logical drives, 69
SMTP server settings, 110
SNMP support
Linux, 157
Windows, 155
software, 2
actions menu, 33
actions menu overview, 194 to 198
agent port number, 65
display options, 59, 61
icons, 202 to 204
installing, 9
Linux, 13
Solaris, 14
VMWare, 15
Windows silent installation, 11
logging into remote systems, 55
main window, 23
main window overview, 23
notification manager, 100
remote systems, 53
standard unit of measure, 60
task manager, 126
software versus agent, 192
Solaris
installing software, 14
starting the agent, 19
starting the software, 17
Solaris OS
installing, 14
spares. See hot-spares
stand-alone application, 16
standard unit of measure, 60
starting software
agent only, 17
Linux, 17
Windows, 16
starting the software
Solaris, 17
startup port number, 55
status
components, 139
disk drives, 27,28
display group systems, 134
enclosures, 32,118, 204
event viewer, 31
event viewer icons, 98
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notification log icons, 106
task events, 128
tasks, 127
view buttons, 29
status icons
enclosures, 118
event viewer, 98
notification log, 106
task manager, 128
storage space, xxvi, 4
advanced, 5
continuing to grow, 6
examples, 4
growing with the software, 4
simple, 4
stripe size, 74
striping, 179
Sun StorageTek RAID Manager
Agent, 3
introduction, 2
support archive file, 168
system groups. See display groups
system requirements, 8
systems
actions menu, 195
enabling alarm, 121
local systems, 53
properties, 139
remote systems, 53
sorting in enterprise view, 59
testing alarm, 122

T

task event viewer, 128

task list, 127

Task Manager
scheduling tasks

task manager
actions menu, 198
buttons, 208
deleting tasks, 131
disabling, 131
missed start times, 130
modifying tasks, 129
monitoring tasks, 127
opening, 126
re-enabling, 132

supported tasks, 199
task event viewer, 128
task list, 127
Task Scheduler. See Task Manager
tasks
deleting, 131
event status, 128
getting started, 1
growing storage space, 4
missed start times, 130
modifying, 129
monitoring, 127
recurring, 123
scheduling, 123
status, 127
supported tasks, 199
tasks tab, 126
TCP/IP port number (default), 100
temperature status icon, 118
terminology, xxvi
test events
email notifications, 112
event notifications, 102
failed email messages, 113
failed event notifications, 103
logged notifications, 102
testing alarm
controller-level, 145
enclosure-level, 148
system-level, 122
text description view, 29
tool bar buttons, 205 to 208

U

user permissions, 20

'}

verifying and fixing logical drives, 78

verifying logical drives, 77,79
automatic verification, 77
background verification, 77
icon, 79
manual verification, 77

view buttons, 29

views
enclosures, 30
full size capacity, 30
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relative size capacity, 31

text description, 29
VMWare

installing software, 15
VMWare OS installation, 15

w

Windows
controller support, 51
installing
silent installation, 11
installing software
silent installation, 11
SNMP support, 155
starting the agent, 18
starting the software, 16
Windows OS
installing, 10
write cache, 75
write-back, 75
write-through, 75
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